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1. Prefatory Comments 
 

1.1 Explanation of LED’s and Beeps  
 

LED  Instrument status 

lights up green Instrument OK and connection to PC OK 

lights up yellow Instrument OK, no connection to PC 

flashes yellow + 1 short beep New CAN is installed after power on of  

instrument 

lights up yellow + 1 long beep CAN correctly installed 

lights up red Shortly after power on of the instrument  

(during initialization) 

flashes red + 2 short beeps Error after power on of instrument /  

CAN module not correctly installed 

 

 

1.2 Operating manual 
 

This Operating Manual is structured as follows: 

The manual covers all manipulations in a work flow order starting from installation via 

regular operation to maintenance. 

In each section you are guided through the respective procedures step by step. The steps 

are consecutively numbered in each section. Explanations on the individual steps are 

added in small type font. 

Explanations on the various types of operations are highlighted specifically. 

For your convenience, illustrations are placed directly next to the respective text. 

 

 

1.3 Typographical conventions   
 

<Add formula>, 

 <OK>, <Close> 

Buttons are printed inside angular brackets in 

bold typeface 

Menu File, Open dialog box  Menu titles and dialog boxes are printed in bold 

type 

File | Open, 

Options | Read 

Menu items are also printed in bold type; menu 

and submenu item are separated by a vertical line. 
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2. Safety Instructions  
 

 

2.1 Safety Instructions 
 

 Hot surface: Care while touching the cover or the lamp, they can be 

hot. 

 Caution! This sign alerts you to important operating procedures 

with a potential danger of damaging the equipment and endanger-

ing your safety on disobeying. Refer to the user and instrument 

manuals for precautionary instructions. 

 This operating manual includes information and warnings that have 

to be observed by the user in order to ensure safe operation of the 

instruments. 

 Please do always act according to the following safety instruc-

tions, before as well as during operation of the system! Before 

set up and operation of the instrument it is necessary to read 

the instructions below as neither safe operation of the instru-

ment nor safety of the user are guaranteed otherwise. Failure 

to follow the instructions may invalidate the warranty. 

 The instrument has been manufactured in accordance with the 

safety requirements for electrical measuring systems. If the law lays 

down regulations on the installation and/or operation of sample 

measuring system, then it is the operator’s responsibility to adhere 

to them. 

 The manufacturer has done everything possible to guarantee that 

the equipment functions safely, both electrically and mechanically. 

The user has to make sure that the instrument will be set up and 

installed properly to guarantee safe operation. 

 The instruments are tested by the manufacturer and supplied in a 

condition that allows safe and reliable operation. 

 This equipment must be installed and used in accordance with the 

manufacturer´s recommendations. Installation must be performed 

by properly trained and authorized personnel. 

 The instrument may only be operated by personnel who have been 

trained on the use of the system. It is strongly recommended that 

all users read this manual prior to use. 

 Never put parts of your body or other devices into the instru-

ment while the unit is in operation. 

 Remove the transportation lock before switching on the in-

strument. 

 Use the instrument only for the designated application. 

 The instrument is designed for indoor use only. 

 BERTHOLD TECHNOLOGIES assumes no liability for any damag-

es, including those to third parties, caused by improper use or han-

dling of the instrument. 
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 The user is responsible for connecting the instrument in accord-

ance with the valid regulations for electrical instruments. 

 Set the instrument up to ensure easy access to the mains switch. 

 The mains supply voltage fluctuations must not exceed +/-10 % of 

the nominal voltage. Maximum voltage to be applied is 253 VAC. 

 The instruments are designed according to these standards: 

IEC / EN 610 10-1: 2001 (2ed) 

CAN / CSA C22.2 No 61010-1-04 

UL 61010-1, 2nd Edition 

 To disconnect the instrument from power the appliance coupler has 

to be removed from the mains.  

 Do not open any instrument doors as long as the instrument is in 

operation. 

 Service and repair work may be carried out by qualified personnel 

only. 

 The operator may only perform the maintenance work described in 

this user guide. 

 There are no exchangeable electrical components in the instru-

ment. In case of malfunction call authorized service personnel. 

 Use only parts described in this manual for servicing. 

 Disconnect power supply before opening the instrument. 

 Pull the power cord to disconnect instrument from power supply. 

 Upon removal of the front and top parts of the housing no safety 

measures are in effect. Be aware of any moving parts. The interior 

of the instrument may reach temperatures that can cause burns. 

Some parts of the instrument may remain hot without visual indica-

tion for some time after the power has been turned off. 

 The electronic unit of the detector generates high voltage. Do not 

touch it during operation! 

 If you can see that the instrument has become unsafe to use, 

switch it off and disconnect it from power supply. 

 If liquid gets inside the instruments, pull the power cord. Clean the 

unit or have it cleaned by an authorized service center. 

 Protect yourself from electrostatic charge, as discharge could dam-

age sensitive instrument parts, especially sensitive parts of the 

computer and electronics boards. 

 When the lid is opened (e.g. filter change) ESD can no longer be 

guaranteed. To avoid any damages to the electronic parts it is rec-

ommended to take precautions (touching the metal case of a safety 

grounded object, wearing a grounding strap, etc.). 

 The system always has to be primed with solutions recommended 

by the kit manufacturer. 

 Use only reagents recommended by the kit manufacturer. 



LB 942 TriStar² Operating Manual 

 12 

 Use reagents only in accordance with the kit manufacturer’s in-

structions. 

 Do not use any flammable or explosive solutions or liquids whose 

mixture is flammable or explosive. 

 Waste (when priming/washing the tubing) always has to be dis-

posed properly: if a waste pump is installed, a bottle has to be con-

nected. If no waste pump is present, a suitable prime plate has to 

be placed below the injectors during priming/washing. 

 Injector solutions may be pumped back only if the appropriate rea-

gent bottle is connected.  

 Observe all statutory requirements for handling biological waste, 

reagents and samples. 

 The operator is responsible for the use of reagents. 

 The units are not for use in in-vitro diagnostic (IVD) proce-

dures. 

 The instrument should be shipped in its own case. For transport all 

transportation locks (e.g. for the plate carrier) have to be installed. 

 For instrument cleaning, please refer to the respective sections in 

this manual. 

 Reliable instrument function can be guaranteed only when original 

spare parts are used. 

The tests and service work recommended by the manufacturer has to 

be performed to make sure that the operator remains safe and that the 

instrument continues to work correctly. Any service and maintenance 

work not described in this user guide has to be performed by authorized 

service personnel. Use the instruments only for the designated applica-

tion. 
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2.2 Consignes de Sécurité  
 

Surface chaude: Attention en touchant la couverture ou la lampe – 

danger de se brûler! 

Attention! Ce symbole d’alarme, vous avertit de prêter attention 

aux consignes opératoires. En effet si vous ne suivez pas ces ins-

tructions, il peu y avoir un risque d’endommagement du matériel et 

également vous faire ecourir des risques pour votre propre sécuri-

té. Il est impératif de respecter les instructions du mode d’emploi et 

de les respecter. 

Ce mode d’emploi contient des informations et avertissements qui 

doivent être suivis par l’utilisateur afin de garantir un fonctionne-

ment sûr des instruments. 

Il est impératif de respecter les consignes de sécurité sui-

vantes non seulement avant la mise en service mais aussi 

pendant le fonctionnement de l’appareil! Avant l’installation et 

mise en service de l’instrument tous les utilisateurs des appa-

reils sont tenus de lire d’abord ces instructions de service, au-

trement ni le fonctionnement correct de l’appareil ni la sécuri-

té de l’utilisateur peuvent être garantis. Ne pas suivre ces ins-

tructions de service peut invalider la garantie. 

 Le appareil a été fabriqué conformément aux prescriptions de sé-

curité en vigueur pour les appareils de mesure électrique. Si 

l’installation et/ou l’utilisation des appareils de mesure de prélève-

ments-échantillons sont/est soumise(s) à des réglementations 

prescrites par la loi, il appartient à l’utilisateur de les respecter. 

 Le constructeur a fait tout le nécessaire pour assurer le fonction-
nement sûr des appareils (du point de vue électrique, électronique 
et mécanique). L’utilisateur est tenu de veiller à ce que les appa-
reils soient installés correctement afin d’éviter toute altération de 
leur utilisation sûre. 

 Les appareils sont contrôlés à l’usine et livrés dans un état assu-

rant la sécurité de fonctionnement. 

 Les appareils doivent être mis en service et utilisés strictement 

conformément aux recommandations du constructeur. La mise en 

service est réservée au personnel formé et autorisé. 

 Les appareils ne doivent être utilisés que par des personnes autori-

sées et leur utilisation est réservée au personnel compétent. Tous 

les utilisateurs des appareils sont tenus de lire d’abord ces instruc-

tions de service. 

 Ne mettez jamais des parties de votre corps ou des objets dans 

l’appareil lorsque celui-ci est en fonctionnement. 

 Enlevez le verrouillage de transport avant la mise sous tension de 

l’appareil. 
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 Utilisez l’instrument uniquement pour les applications désignées 

compatibles. 

 L’appareil est destiné uniquement pour une utilisation en intérieur 

de bâtiments. 

 BERTHOLD TECHNOLOGIES décline toute responsabilité de 

dommages résultant d’une utilisation non conforme à l’emploi pré-

vu, y compris les dommages causés à des tiers. 

 Les variations sur la tension du secteur ne doivent pas dépasser +/- 

10% de la valeur nominale (max. 253 VAC). 

 L’utilisateur porte la responsabilité de la mise en service de 

l’appareil selon les prescriptions électriques en vigueur. 

 Les appareils correspondent aux prescriptions de la norme: 

IEC / EN 610 10-1: 2001 (2ed) 

CAN / CSA C22.2 No 61010-1-04 

UL 61010-1, 2nd Edition 

 Pour arrêter et débrancher l’instrument la fiche doit être retirée hors 

de la prise. 

 Ne pas ouvrir le couvercle lors du fonctionnement de l’appareil. Ar-

rêtez l’instrument avant. 

 Les travaux d’entretien et de réparation devront être confiés exclu-

sivement à des spécialistes dûment formés. 

 Les travaux d’entretien uniquement décrits dans le manuel peuvent 

être effectués par l’utilisateur. 

 Pour les travaux d’entretien, utiliser exclusivement les pièces men-

tionnées. 

 Avant d’ouvrir l’appareil, couper l’alimentation en courant. 

 Arrêter l’appareil avant de retirer la fiche. 

 Si vous ouvrez l’appareil, les sécurités ne sont plus activées (capôt 

et parties de la façade de l’appareil). Faites attention aux parties 

mobiles. L’intérieur de l’appareil et certaines pièces peuvent at-

teindre des températures pouvant provoquer des brûlures si il y a 

contact. Appareil éteint, des parties peuvent rester chaudes alors 

qu’il n’y a pas d’indication visible de température élevée. 

 Positionner l’appareil de manières à ce que les interrupteurs soient 

accessibles. 

 Si vous vous apercevez que le fonctionnement de l’appareil n’est 

plus sûr, il faut alors l’arrêter et le débrancher de la prise secteur. 

 Si du liquide a pénétré dans l’appareil il faut immédiatement le dé-

brancher. Ouvrir l’appareil et le nettoyer ou bien le faire nettoyer par 

une agence de service après vente autorisée. 

 Protégez vous des charges électrostatiques afin d’éviter de provo-

quer des décharges qui pourraient endommager des parties sen-

sibles de l’appareil telles que les cartes électroniques ou PC. 

 Ne pas utiliser des liquides inflammables ou explosifs ni de liquides 

dont le mélange est inflammable ou explosif. 
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 Respecter toutes les prescriptions légales concernant la manipula-

tion des déchets biologiques, des réactifs et des échantillons. 

 L’utilisateur assume la responsabilité exclusive de l’utilisation 

des réactifs. 

 Le dispositif n'est pas destiné à être utilisé dans In Vitro Dia-

gnostic. 

 Transporter l’appareil uniquement dans son emballage d’origine. 

Lors du transport, bloquer le support de plaques à l’aide de la vis 

d’arrêt. 

 Pour le nettoyage de l’instrument veuillez vous référer au para-

graphe correspondant dans ce mode d’emploi. 

 Le fonctionnement correcte ne peut être garantit qu’à la condition 

que des pièces de rechange appropriées sont utilisées. 

Afin d’assurer la sécurité de l’utilisateur et le bon fonctionnement des ap-

pareils, effectuer les travaux d’inspection et d’entretien recommandés par 

le fabricant. Toutes les mesures d’entretien et de réparation allant au-

delà de celles spécifiées dans ce manuel sont réservées aux techniciens 

autorisés. 
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2.3 Sicherheitshinweise  
 

Heiße Oberfläche: Vorsicht beim Berühren der Abdeckung bzw. der 

Lampe, sie können heiß sein. 

Die vorliegende Bedienungsanweisung enthält Informationen und War-

nungen, die vom Benutzer befolgt werden müssen, um einen sicheren 

Betrieb der Geräte zu ermöglichen. 

Dieses Zeichen weist den Benutzer auf wichtige Punkte hin, deren Be-

achtung unerlässlich ist. 

Die folgenden Sicherheitshinweise sind sowohl vor der Inbetrieb-

nahme als auch während des Betriebs des Gerätes unbedingt zu 

beachten. Vor Inbetriebnahme des Gerätes ist es zwingend erfor-

derlich, die Bedienungsanleitung zu lesen, da ansonsten die Si-

cherheit des Gerätes und des Benutzers nicht gewährleistet wird. 

Das Gerät wurde in Übereinstimmung mit den Sicherheitsanforderun-

gen für elektrische Messgeräte hergestellt. Bestehen für die Errichtung 

und/oder den Betrieb von Probenmessgeräten gesetzlich vorgeschrie-

bene Regelungen, so ist es die Aufgabe des Errichters und Betreibers, 

diese einzuhalten. 

Der Hersteller hat alles unternommen, um ein sicheres Arbeiten der 

Geräte (bezüglich Elektrik, Elektronik und Mechanik) zu gewährleisten. 

Der Benutzer muss dafür sorgen, dass die Geräte so aufgestellt und in-

stalliert werden, dass ihr sicherer Gebrauch nicht beeinträchtigt wird. 

Die Geräte sind werkgeprüft und wurden in betriebssicherem Zustand 

ausgeliefert. 

 Die Geräte dürfen nur von autorisierten Personen in Betrieb genommen 

und nur von eingewiesenem Personal bedient werden. Alle Benutzer, 

die mit den Geräten arbeiten, müssen zuerst diese Bedienungsanlei-

tung lesen. 

 Die Geräte dürfen nur von dafür geschultem Personal betrieben wer-

den. Es wird allen Anwendern empfohlen, diese Bedienungsanleitung 

vor Benutzung zu lesen. 

 Während des Betriebes nicht in die Geräte faseen oder andere Teile in 

die Geräte einführen. 

 Transportsicherungen vor dem Einschalten entfernen. 

 Die Geräte dürfen nur für den vorgesehenen Zweck eingesetzt werden. 

 Berthold Technologies übernimmt keinerlei Gewährleistung, auch für 

Schäden gegenüber Dritten, die durch unsachgemäße Handhabung der 

Geräte hervorgerufen werden. 

 Die Geräte dürfen nur innerhalb geschossenen Räumen betrieben wer-

den. 

 Die Stromversorgung darf nicht mehr als ±10 % des Nominalwertes 

aufweisen. Maximal sind 253 V Wechselstrom erlaubt. 

 Es liegt im Verantwortungsbereich des Anwenders, dass die Geräte 

nach den lokalen elektrischen Vorschriften installiert werden. 
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 Die Geräte entsprechen den Vorschriften der: 

IEC / EN 610 10-1: 2001 (2ed) 

CAN / CSA C22.2 No 61010-1-04 

UL 61010-1, 2nd Edition 

 Nicht öffnen, wenn das Gerät in Betrieb ist. 

 Service- und Reparaturarbeiten dürfen nur von Fachleuten ausgeführt 

werden. 

 Es dürfen nur die im Handbuch beschriebenen Wartungsarbeiten vom 

Anwender ausgeführt werden. 

 Bei Wartungsarbeiten dürfen nur die angegebenen Teile verwendet 

werden. 

 Vor dem Öffnen des Gerätes ist die Stromzufuhr zu unterbrechen. 

 Um das Gerät vollkommen vom Netz zu trennen, kann das Netzkabel 

gezogen werden. 

 Wenn das Gerät geöffnet ist sind Sicherheitsmaßnahmen nicht mehr in 

Betrieb. Auf bewegliche Komponenten achten! Das Innere der Geräte 

kann Temperaturen erreichen, die Verbrennungen verursachen kön-

nen. Einige Teile können heiß bleiben ohne sichtbare Zeichen, auch 

nachdem das Gerät abgeschaltet worden ist. 

 An der Multiplier-Einheit liegt Hochspannung an. Nicht berühren, wenn 

das Gerät läuft. 

 Stellen Sie das Gerät so auf, dass Sie es leicht ein- und ausschalten 

können. 

 Bei Beeinträchtigung der Betriebssicherheit sind die Geräte abzuschal-

ten und vom Netz zu trennen. 

 Ist Flüssigkeit in das Innere des Gerätes gelangt, Netzstecker ziehen. 

Das Gerät öffnen und reinigen bzw. durch eine autorisierte Servicestelle 

reinigen lassen. 

 Elektrostatische Aufladungen (z.B. durch Teppichböden) müssen beim 

Öffnen des Gerätes verhindert werden, da Entladungen am Gerät zur 

Beschädigung elektronischer Teile führen können. 

 Das System muss immer ausreichend mit den vom Reagenzienherstel-

ler empfohlenen Lösungen gespült werden. 

 Es dürfen nur Reagenzien verwendet werden, die vom Reagenzherstel-

ler empfohlen werden. 

 Reagenzien dürfen nur in der vom Reagenzienhersteller vorgeschrie-

benen Art und Weise verwendet werden. 

 Es dürfen keine entzündlichen oder explosiven Flüssigkeiten oder 

keine Flüssigkeiten, deren Mischung entzündlich oder explosiv ist, 

verwendet werden. 

 Es ist immer auf eine korrekte Entsorgung des Abfalls (beim Fül-

len/Spülen der Leitungen zu achten: Bei integrierter Abfallpumpe ist ein 

Behälter anzuschließen. Wenn keine Abfallpumpe vorhanden ist, muss 

beim Spülen/Füllen der Leitungen eine entsprechende Auffangwanne 

unter den Injektoren plaziert sein. 
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 Das Zurückpumpen der Injektorflüssigkeit darf nur dann vorgenommen 

werden, wenn die entsprechenden Reagenzbehälter angeschlossen 

sind.  

 Beachten Sie alle gesetzlichen Vorschriften für den Umgang mit biolo-

gischem Abfall, Reagenzien und Proben. 

 Die Anwendung der Reagenzien liegt im alleinigen Verantwor-

tungsbereich des Benutzers. 

 Die Geräte sind nicht für den Einsatz in der In Vitro Diagnostik be-

stimmt. 

 Das Gerät sollte nur in der eigenen Verpackung transportiert werden. 

Beim Transport ist darauf zu achten, dass alle Transportsicherungen 

eingesetzt werden (z.B. die Sicherung für den Plattenträger). 

 Zum Reinigen des Gerätes bitte den entsprechenden Teil dieser Bedie-

nungsanleitungen beachten. 

 Ordungsgemäße Funktionalität kann nur bei Verwendung der Origina-

lersatzteile garantiert werden. 

Für die Sicherheit des Benutzers und die Funktionsfähigkeit der Geräte sind 

die vom Hersteller empfohlenen Überprüfungen und Wartungsmaßnahmen 

durchzuführen. Alle über die Betriebsanleitung hinausgehenden Wartungs- 

und Instandhaltungsmaßnahmen dürfen nur von autorisierten Technikern 

ausgeführt werden. 
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3. Warranty and Technical Issues 
 

 

3.1 Special spare parts 
 

The following spare parts are safety parts: Use the original part from the manufacturer or 

direct agent only. 

 

Power supply  input 100 - 240 VAC, 4 A 

output 24 VDC, 9.2 A, max 221 W 

GST220A24-R7B 

part no. 59048 

   

 

 

 

3.2 Warranty statement  
 

The instrument is sold in accordance with the general conditions of sale of Berthold 

Technologies GmbH & Co KG and its affiliates and representatives. 

Berthold Technologies warrants this product to be free of defects in material and work-

manship for a period of 12 months from the date of delivery, ex works Bad Wildbad. 

Berthold Technologies or its authorized representative will repair or replace, at its option 

and free of charge, any product that under proper and normal use proves to be defective 

during the warranty period.  

 

Berthold Technologies shall in no event be liable or responsible for any incidental or 

consequential damage, either direct or indirect. 

 

The above warranty shall not apply if: 

a) the product has not been operated in accordance with the operating manual 

b) the product has not been regularly and correctly maintained 

c) the product has not been repaired or modified by a Berthold Technologies 

authorized representative or user 

d) parts other than original Berthold Technologies parts are used 

e) the product and parts thereof have been altered without written authorization 

from Berthold Technologies GmbH & Co KG 

e) the product has not been returned properly packed in the original Berthold 

Technologies packaging 

 

This warranty does not apply to any third party product involved in the application. 

 

Berthold Technologies reserves the right to refuse to accept the return of any product 

that has been used with radioactive or (micro)biological substances, or any other mate-

rial that may be deemed hazardous to employees of Berthold Technologies. Such prod-

ucts have to be properly decontaminated and marked. Before returning products to 

Berthold Technologies ensure the devices are properly decontaminated and the form 

“Confirmation on decontamination”  is properly filled in and will be accompanying the 

product. (See appendix for a blank form) 

 

Before returning products to Berthold Technologies, a returns/repair number must be 

obtained and clearly identified on the packing and documents. Call Berthold Technolo-
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gies to get this number. Retain the original packaging for use if the instrument needs to 

be returned to Berthold Technologies. 

 

 

 

3.3 Customer service  
 

Customer service will be provided in the first instance by the network of Berthold 

Technologies representatives. In the event of any problem experienced with your in-

strument, the first recourse should be your local Berthold Technologies representa-

tive. For further problems requiring hardware or software expertise, the Technical Sup-

port group at Berthold Technologies GmbH & Co KG will be available by phone, fax or 

email to deal with your queries. Here is their address, phone, fax and e-mail: 

 

Berthold Technologies GmbH & Co KG 

Technical Support 

Calmbacher Str. 22 

75323 Bad Wildbad 

Germany 

Phone: +49 7081 177 114 

Fax: +49 7081 177 301 

Email: service@berthold.com 

 

 

At the end of this manual you will find a Customer Reply Form (Appendix section). If a 

problem arises with the instrument which you are not able to resolve, please fill in this 

form. This form should then be transmitted to your Berthold Technologies representative 

or to Technical Support at Berthold Technologies, where it will receive early attention. 

 

Please also make sure that you have the relevant information available before contact-

ing Berthold Technologies. Helpful information would include: 

 

- serial numbers, part number, revision: 

see production label on instrument 

- software and firmware versions 

- monitor and log files (refer to the respective service manuals) 

 

 

 

mailto:service@berthold.com
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4. Introduction  
 

4.1 Intended use 

The TriStar² is a modular multi-technology microplate reader for different types of fluo-

rescent, luminescent and absorbance applications.  

The units are not for use in in-vitro diagnostic (IVD) procedures.  

These units are not designed for use in hazardous areas. 

 

4.2 Description 

The TriStar² microplate reader is distinguished by its exceptionally high sensitivity allow-

ing detection limits in scientifically relevant magnitudes with low reagent consumption. 

Detector sensitivity and stability are the result of Berthold Technologies´ experience with 

thousands of photon counters. True photon counting  has the benefit that no user pa-

rameters need to be set, ensuring the same conditions are used for every measurement 

during the instrument´s entire life time. The fast photon counting circuitry provides a dy-

namic range in excess of six orders of magnitude, which complements the range of the 

latest assays. 

A proprietary design of the optical system achieves absolute minimisation of cross-talk  

down to 10-6 (depending on the type of microplate). 

The PC based ICE operating software has been designed with the basic research scien-

tist in mind and offers straight forward access to the respective parameter settings. Be-

sides raw data measurements the user can select dual measurements with ratio calcula-

tion or kinetic and scanning. 

The instrument can read solid plates as well as strip plates  from 6 to 384 well formats 

with a height not exceeding 21 mm (respective adapter frames need to be applied). 

 

4.3 Recommendations for proper handling 

To obtain good and consistent results please follow these recommendations : 

 Do not expose instrument to direct sunlight 

 Set up instrument in dry rooms 

 Open lid for loading filter/microplates or cleaning only to keep light and dust out 

 Keep plate carrier free from dirt 

 Remove spilled reagents immediately with damp cloth or optical grade tissue 

 Very bright samples may cause saturation of the PMT (indicated by an “Overload” 

message); let the PMT recover for a few seconds 

 

To avoid damages to mechanical, electrical and optical components obey to these rules:  

 Load microplates correctly 

 Do not use microplates or strip plates with heights exceeding 21 mm 

 Do not fill the microplates above their specified maximum volume 

 Do not shake completely filled microplates in the instrument 



LB 942 TriStar² Operating Manual 

 22 

 Do not overfill the reagent trough as liquid spills in the injector compartment may 

cause severe damage to the electrical system; take special care when ice in the 

trough starts to melt 
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5. Installation  
 

Read this part completely prior to starting with the first steps and make sure that all pre-

requisites are met as described below. 

 

 

5.1 Unpacking and Set up  
 

1. Unpack TriStar² and accessories 

2. Put TriStar² onto an appropriate laboratory desk 

 

3. Remove external power supply  from its box and 

connect to power cord 

 

 

4. Open the big front flap and remove transporta-

tion safety device  

 

 

5. Connect USB cable  to USB port  of instrument 

 

  
   USB port 
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6. Connect power cord to the respective socket of 

the instrument 

 

7. Verify the mains switch  is in OFF position 

 

 
 
 Mains switch Mains socket 

 

8. Check if the power supply is within the permissi-

ble range of the operating voltage (110 – 240 

VAC, 50/60 Hz) 

 

Connect instrument only if it is matching! 

 

9. Put the jack of the external power supply into the 

wall outlet 

 

 

10. For the consecutive software installation the in-

strument should remain turned off. 
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5.2 Software Installation  
 

The instrument can be run with either ICE or Mikrowin software. Dependent on your soft-

ware configuration follow either the instructions for ICE software or Mikrowin software in-

stallation respectively. 

 

5.2.1 Installation of ICE operating software  
 

Note:  The software requires a computer with Windows operating system (Windows 

2000, Windows XP, Windows Vista, Windows 7) . For installation local adminis-

trator level is recommended but not necessary. 

Note:  As the software requires some additional resources for proper operation the set 

up wizard will check for the presence of these resources (.NET Framework 2.0  

and Crystal Reports for .NET Framework ) on the computer. If the resources 

are found the installation of Instrument Control and Evaluation (ICE) software is 

started. 

In case these resources are not available on the computer the set up wizard will 

start with the installation of these resources. 

 

1. Close all Windows applications before you start 

installing the software 

 

 

2. Insert software CD into CD drive 

The set up routine starts automatically 

 

In case the installation does not start automati-

cally browse to the CD´s root directory and dou-

ble click Setup.exe 
 

 

3. Click <Run> when the Security Warning dia-

logue appears 

 

This or similar dialogues may appear during 

consecutive steps of the installation due to 

Windows security settings. Always confirm 

the messages to continue the installation. 

 

 

 

4. Choose a language 

5. Click <OK> 
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6. InstallShield will configure itself 

 

 

7. Click <Next> to start installation procedure 

 

 

8. Choose an installation directory 

 

Due to support issues it is recommended to use 

the defaulted one 

 

9. Click <Next> 
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10. Click <Install> 

 

 

11. The installation procedure will be executed au-

tomatically 

 

Click <Accept> or <Run> should any warning 

messages appear 
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12. Click <Finish> 

 

 

13. After a successful installation an ICE icon will be 

visible on the desktop 

 

 

 

 

 

5.2.2 Installation of Mikrowin 2000 operating software  
 

Note:  The software requires a computer with Windows operating system (Windows 

2000, Windows XP, Windows Vista, Windows 7) . For installation local adminis-

trator level is recommended but not necessary. 

Note:  For the installation of MikroWin and driver software as well as for any updates 

and upgrades of the respective software the user has to have local Administra-

tor rights for the computer. 

Note:  Advanced versions are delivered with a hard lock (parallel or USB) for copy pro-

tection. The hard lock is matched with the installation CD. The hardlock needs to 

be attached during all operations with MikroWin. The Lite version needs to get 

activated with an activation code during or after installation. 

Note:  When a USB hard lock  is used the installation has to be performed without the 

hard lock plugged in. The USB hard lock has to be put into the PC right after in-

stallation. 

 

1. Close all Windows applications before you start 

installing the software 

 

 

2. Insert software CD into CD drive 

The set up routine starts automatically 

 

In case the installation does not start automati-

cally browse to the CD´s root directory and dou-

ble click Setup.exe 

 

 



LB 942 TriStar² Operating Manual 

 29 

3. Select language and confirm with <OK>. The 

setup assistant is started 

4. Enter name and company and click <Next> 

5. Choose destination location (see screen shot 

to the right).  

The following path is defaulted  

C:\Program Files\Mikrowin 2000 

For support reasons it is recommended to keep the 

default settings 

If you wish to install the program to another folder, 

click <Browse> and select another folder 

6. Click <Next> 

 

 

 

7. Select the setup type 

We recommend that you choose Typical for your first 

installation to ensure that all program components are 

installed. 

If you are familiar with the system, you may choose 

Custom to select the components you need for your 

application. You may especially not want to install the 

instrument drivers LB96V and Null Device. 

8. Click <Next> 

 

 

9. Select the desired components or deselect those 

components you don’t want to install. 

10. Click <Next> 
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11. Add program icon to the Mikrowin 2000 program 

folder. 

12. Click <Next>. 

Installation is carried out and successful comple-

tion is indicated. 

 

 

 

11. Click <Finish> to complete setup 

 

 

12. Attach Mikrowin 2000 USB hard lock   for Ad-

vanced versions 

or 

Run the Activation procedure for Lite versions 

 

 

 

 

5.2.3 Activation of MikroWin Lite Software  
 

The Activation prodedure needs to be executed only when a new installation 

of Mikrowin 2000 has been performed. 

 

1. This dialog will be displayed when starting a not 

yet activated MikroWin 2000 Lite software with-

out the instrument switched on (v 4.29 and high-

er) 

It is recommended to switch off and disconnect the 

instrument during software activation. 

 

 

2. Go to Help | Program Activation 

There are 3 ways to acquire the activation code: 

I) on line via internet (proceed with step 3) 

II) via email (proceed with step 8) 

III) via fax (proceed with step 16) 

 

Activation via internet: 

3. Enter serial number of instrument 

4. Click <Auto Activation> 

5. Click <OK> on the next screen displayed to con-  
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firm the activation process 

6. Code will be transferred online and will be auto-

matically entered into the respective boxes 

Activation code will be returned within German office 

hours only 

7. Once code is entered in respective fields click 

<OK> 

 

 

Activation via email: 

8. Click <Copy to Clipboard> 

9. Click <Send eMail> 

10. Select suitable email profile 

11. use “MikroWin Program Activation” as subject 

and provide these details of your system: Pro-

gram ID Code, Device Serial Number and 

Program Licence Code 

12. Email with respective activation code will be re-

turned within 24 h 

13. Copy code to clipboard. 

14. Re-access the Program activation menu and 

click <Paste from Clipboard> 

15. Click <OK> 

 

 

Activation via fax: 

16. Click <Copy to Clipboard>. 

17. Click <Show Fax Form>. 

18. Paste Program ID Code into respective fields 

and enter additional required information. 

 

 

 

 

 

5.2.4 Installation of TriStar² driver  
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In order to be able to communicate with the instrument via the USB port (executing opera-

tions and receiving data) the driver software needs to be installed and set up. 

The instrument needs to be switched off during this process. 

 

1. Close all Windows applications before you start 

installing the software 

2. Make sure the instrument´s power switch is in 

OFF position 

 

3. Insert software CD into CD drive 

The set up routine starts automatically 

 

In case the installation does not start automati-

cally browse to the CD´s root directory and dou-

ble click Setup.exe 

 

Click <Yes> or <Accept> or <Run> should any 

warning message appear on your screen 

 

 

 

4. Install Shield will prepare the installation 

 

 

 

 

 

 

 

 

 

 

 

5. Click <Next> 
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6. Select the installation type for or ICE (or 

MikroWin depending on which kind of evaluation 

software you are using and have installed prior) 

 

7. Click <Next> 

 

 

8. Choose an installation directory 

 

Due to support issues it is recommended to use 

the defaulted one 

 

9. Click <Next> 

 

 

10. Click <Install> 

 

Click <Accept> or <Run> should any warning 

messages appear 
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11. Click <Next> 

 

 

12. Wait for the installation procedure to be finished 

 

Note: Certain Windows versions/configurations 

will show security dialog boxes such as 

“Do you want to allow the following pro-

gram from an unknown publisher to make 

changes to this computer”. In this in-

stance click <Yes>, <OK> or <Run> 
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13. Click <Finish> 

 

 

14. Click <Finish> 

 

 

15. Connect the USB cable to a USB port of the 

computer 

 

 

 

16. A message will be shown in the task bar during 

the USB driver installation 

 

 

17. After a few minutes a message confirming the 

successful installation will be displayed in the 

task bar  

 

18. Turn instrument on by putting mains switch into 

ON position 
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19. Open ICE software or Mikrowin software de-

pendent on which kind of installation you have 

done prior 

  

 

20. Select TriStar² in View menu (ICE) 

 

or 

 

Select the menu item Installation | Driver 

(Mikrowin) to open the Installation Driver dialog 

box with a separate tab for each driver type. 

 

 

 

21. Go to Instrument menu and select Properties 

(ICE) 

 

or 

 

Highlight BertholdTech TriStar2 and click on 

<Driver Setup> (Mikrowin) 
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22. Select the entry starting with BT60…. (e.g. 

BT601004) in the ComPort section 

 

The raw data are usually displayed as RLU rep-

resenting the total amount of counts acquired 

during the reading time per well 

By checking Calculate RLU/s  the total amount 

of counts will be divided by the respective read-

ing time 

 

23. Click <Get Configuration> 

the available injectors (with their volume) of the 

instrument will be automatically checked as well 

as Temperature Control and PMT Cooling when 

installed 

 

24. Click <OK> 

 

25. Mikrowin only: Click <OK> to close the Instal-

lation | Driver dialogue 

 

 

 

26. The instrument is now ready to use 
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5.3 Installing Filters  
 

The instrument comes with an excitation and an emission filter slide, each of capable of 

holding up to 5 filters. 

If the instrument is equipped with absorbance reading technology a 450 nm absorbance filter 

is included. 

If the instrument is equipped with fluorescence reading technology a 485/14 nm excitation fil-

ter and a 535/25 nm emission filter are included. 

In case additional filter are required they can be ordered individually and can easily be in-

stalled both physically and in the software. 

 

5.3.1 Excitation filters  
 

1. Select Excitation Filter Slide in the Instrument 

menu 

 

 

2. Click <Add> 

 

 

3. Define a (descriptive) Name for the new filter 

4. Check the Usage 

5. Click <OK> 
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6. Highlight the new filter in the Unused Filters list 

and drag it into an empty position of the filter 

slide 

 

 

 

7. Open the big flap at the front 

8. Click <Eject Slide> 

9. Remove excitation filter slide from the instrument 

 

emission filters excitation filters 

 

10. Mount the filter(s) into the position(s) defined in 

the software 

for excitation and absorbance filters with diame-

ters of 12.7 mm (½ inch), 15 mm or 25 mm (1 

inch) can be used 

12.7 mm filters need to be mounted with a 

matching adapter (ID 57194-005) and a match-

ing clamp ring (ID 57195-005) 

15 mm filters need to mounted with a matching 

adapter (ID 54666-005) and a matching clamp 

ring (ID 34767-005) as well 
 

 25 mm 15 mm 12.7 mm 

 

 

excitation filters mounted 

 

57195-005 

54666-005 57194-005 

34767-005 
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11. Insert the slide again until the front of the slide is 

aligned with the front of the instrument 

12. Click <OK> 

13. Close the front flap 

 

 

14. Click Calibrate Slide when more than filter have 

been installed or the instrument has been set up 

for the first time 

15. Highlight the single filter by right-clicking and 

click Calibrate Filter when only a single new fil-

ter has been added 

 

 

16. The instrument will test and finally store the op-

timized lamp energy for each filter according to 

its transmission specifications; this may take a 

few minutes 

Do not switch off the instrument during this 

procedure! 

17. Click <OK> (once the dialog is black and active 

again) 
 

 

 

 

 

5.3.2 Emission filters  
 

1. Select Emission Filter Slide in the Instrument 

menu 
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2. Click <Add> 

 

 

3. Define a (descriptive) Name for the new filter 

4. Check the Usage 

5. Click <OK> 

 

 

6. Highlight the new filter in the Unused Filters list 

and drag it into an empty position of the filter 

slide 

 

 

 

7. Open the big flap at the front 

8. Click <Eject Slide> 

9. Remove emission filter slide from the instrument 

 

emission filters excitation filters 
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10. Mount the filter(s) into the position(s) defined in 

the software 

25 mm filters are recommended for emission as 

they are ideally matching the emission light path 

filters with diameters of 12.7 mm (½ inch) and 15 

mm may be used but are not recommended as 

sensitivity will be compromised 

12.7 mm filters need to be mounted with a 

matching adapter (ID 57194-005) and a match-

ing clamp ring (ID 57195-005) 

15 mm filters need to mounted with a matching 

adapter (ID 54666-005) and a matching clamp 

ring (ID 34767-005) as well 

 

 

Emission filters mounted 

 

Position 5 is reserved for lumi-

nescence readings 

11. Insert the slide again until the front of the slide is 

aligned with the front of the instrument 

12. Click <OK> 

13. Close the front flap 

 

 

14. Click <OK 
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6. Instrument Control and Evaluation Software 
 
 

6.1 ICE Directories and Files 
 
 

The directories for data and parameter files are defaulted as described below. Any acces-
sible directory on the computer and the local network can be selected though when sav-

ing data and parameter files using the “Save … File As…” command. 
 

Default directories  
 Data files My Documents\ICE\DataTriStar2 
 Protocol files My Documents\ICE\ParaTriStar2 

 
In consequence each Windows user has own directories containing his data and protocol 
files. 
 
 

File Names  
There is no limitation in naming data and protocol files other than the Windows conven-
tions. 
 
Data file names are to be defined prior to measurement start. Renaming is possible using 

the “Save Data File As…” command producing a copy of the data file with a new name. 
 
Protocol file names are to be defined at the end of creating a protocol. Renaming is pos-

sible using the “Save Protocol File As…” command producing a copy of the protocol file 
with a new name. 
 
 

File Types  
ICE works with 5 file types indicated by the respective file name extensions. 
 

 Protocol files have the extension .wgp 

 Data files have the extension .wgd 

 Standard curve files have the extension .wgs (to be used as reference curves) 

 Multiple Analyte profiles have the extension .wgm 

 Customized prime sequences have the extension .wge 
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6.2 ICE User Interface  
 

6.2.1 ICE default set up 
 

The next figure shows the default start-up screen  of ICE. 

 

 
 

To return to the default layout after any changes may have been made check Navigation 

Panel and TriStar² in the View menu. 
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6.2.2 File menu  
 

The File menu contains commands to open and save data and protocol files. 

 

 
 

New erases data display to start a new measurement 

Open Protocol File… opens an existing protocol 

 

 

Save Protocol File saves loaded protocol file 

Save Protocol File As… saves loaded parameter settings with a new name 

Open Data File opens an existing measurement 

Save Data File saves displayed data 

Save Data File As… saves displayed data with a new name 

Export exports the data set as EXCEL file according to the settings 

made in the protocol 

Print prints the selected data set shown on the screen 

Print Preview displays a preview of the print-out 

Exit closes ICE software 
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6.2.3 View menu  
 

The View menu defines how the user interface and data are displayed. 

 

 
 

Navigation Panel shows/hides navigation panel on the left 

TriStar² adjusts user interface for TriStar² 

Protocol Wizard starts wizard for protocol creation 

Data displays raw data (RLU or RLU/s) 

Result displays calculated data 

Sample ID displays sample IDs 

Standards displays standard concentrations 

Result Mode to select the content of the result display 

  

 

 



LB 942 TriStar² Operating Manual 

 47 

6.2.4 Instrument menu  
 

In the Instrument menu basic instrument settings and communication may be accessed. 

 

 
 

Properties instrument driver settings 

  

Load Plate moves plate into the instrument 

Unload Plate moves plate out of the instrument 

Injector Settings general setting for wash and prime sequences 

Prime starts the priming sequence (filling the lines) 

Wash starts the washing sequence (cleaning the lines) 

Refresh injects once to fill the tip (e.g. after longer periods of idleness) 

Unload Injector starts the unloading sequence (recovering reagents back into 

the reservoir) 
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Excitation Filter Slide dialogue for definition and positioning of excitation filters 

Emission Filter Slide dialogue for definition and positioning of emission filters 

Plate Editor dialogue for definition of microplate dimensions 

  

 Note: only 6 to 384 well plates are supported in the TriStar² 

 Note: only plate heights of up to 21 mm are supported in the 

TriStar² 

Boot Instrument establishes communication and boots instrument 

Shipping Brace moves XY table to a position enabling the insertion of the 

transportation lock 
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6.2.5 Tools menu  
 

In the Tools | Options menu you can define the default root directory for the protocol 

(ParaTriStar2) and data (DataTriStar2) folders. 

 

 
 

 

The Tools | Prime Customize menu user and/or application specific prime procedures 

can be defined. 

 

 
 

For the setting and options please read chapter "Priming Tubings" 
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6.2.6 Help menu  
 

The Help menu allows you to view basic software information. 
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7. Operation with ICE 
 

 

Running measurements on the TriStar² is straight forward. The procedure is the same for all types 

of assay types, e.g. Raw Data, Dual Label, Kinetic, Repeated and Scanning. A measurement can 

be carried out immediately after a stored protocol is selected. At the end of each measurement the 

results are stored and may be printed or exported. 

Result file names can be given without limitation. The extension is fixed, though. This is valid for 

measurement protocols as well. 

 

 

7.1 Adding and Editing Microplate Dimensions  
 

 

Microplates can differ in their dimensions dependent on brand and type. Please refer to 

the manufacturer´s most recent information for exact dimensions of the microplates. 

 

Microplates must be defined in the plate editor prior to defining a measurement protocol. 

 

1. Click Plate Editor in the Instrument menu 

 

 

 

2. Click <New Plate> or select a plate with match-

ing well format and click <Copy> 
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3. Assign a (descriptive) Name 

4. Insert the Number of rows, e.g. 8 for a 96 well 

plate 

5. Insert the Number of columns, e.g. 12 for a 96 

well plate 

6. Insert the total Height of the microplate 

most 96 and 384 well plates are between 14 and 15.5 

mm 

7. Insert the Stacking height of the microplate 

the stacking height is the resulting height (the visible 

part) when plates are put on top of each other (e.g. in a 

plate stacker) 

in case this information is not available from the plate 

manufacturer the stacking height can be derived by 

stacking 2 plates and measuring the total height; by 

subtracting the regular height of one of the plates the 

resulting value will be the stacking height 

8. Insert the distance between the left outer edge of 

the plate and the center of well A1 

9. Insert the distance between to upper outer edge 

of the plate and the center of well A1 

10. Insert the distance between the well centers of 

consecutive rows (vertical well distance) 

11. Insert the distance between the well centers of 

consecutive columns (horizontal well distance) 

12. Check the usage TriStar2 

you may check additional instruments in case you have 

multiple instruments in operation 

13. Click <Apply> 

14. Click <OK> 

 

 

 

15. The plate can now be used in the protocol files 
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7.2 Single Raw Data measurement  
 

 

A raw data measurement generates pure RLU (or RLU/s) values for each measured well. 

This measurement type is useful in luminescent research assays to determine ATP con-

tent, single reporter gene expression, activities of caspases, kinases and many other en-

zymes. 

 

7.2.1 Defining a Single Endpoint protocol  
 

If you want to use an already existing protocol you may proceed with the next paragraph. 

 

16. Click icon Protocol Design in the left-hand Nav-

igation bar 

 

the navigation bar will appear in a new design 

 

 

17. Click the new icon in the left-hand Navigation 

bar 

 

 

 

again, the navigation bar will appear in a new de-

sign 

 

 

 

for editing an existing protocol use the edit icon 

 

 

18. The start up screen of the protocol wizard will 

show up 

Click <Next> 
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19. Enter a (descriptive) Name for your protocol 

20. Define the reading orientation: 

by column or by row 

21. Check Meander to have the instrument read one 

row from the left to right and the consecutive one 

from right to left or one row from top to bottom 

and the consecutive from bottom to top 

22. Check Keep Plate after Measurement in case 

you want the microplate being kept inside the in-

strument after the reading being finished 

23. Check Temperature to activate the temperature 

control for this protocol 

24. Define the target temperature 

the instrument will start to heat the plate com-

partment as soon as the protocol file will be load-

ed 

Robot, Barcode and Multi Plate Data File Mode 

are currently not active 

25. Click <Next> 

 

 

 

26. Select the Plate Type (microplate format) 

 

Note: the microplate has to be defined in the 

Plate Editor prior to defining a protocol 

 

 

 

27. Select the wells to be measured by clicking the 

Measurement radio button 

 for the whole plate, click the top left corner 

 for a row, click the respective character 

 for a column, click the respective number 

 for an area, click and drag the mouse 

 for an individual well, click into it 

Wells with a gray outside area are selected for 

measurement 
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28. Select the wells to be injected into and the re-

spective injector by clicking the Inj 1, Inj 2 or Inj 3 

radio button 

 for the whole plate, click the top left corner 

 for a row, click the respective character 

 for a column, click the respective number 

 for an area, click and drag the mouse 

 for an individual well, click into it 

Wells coloured in the respective colour are inject-

ed into 

Note: only wells to be measured can be injected 

into 

29. Click <Next> 

 

 

 

Define the Measurement Operations 

 Available operations are shown on the left-

hand area 

 Allowed operations are indicated by a check 

mark 

 Double-clicking an operation open the specif-

ic properties dialogue 

 Confirming the settings by clicking <OK> se-

lects the operation and adds it to the opera-

tion sequence visible in the right-hand area 

 The operation may be executed 

by plate the operation will be executed for 

all selected before the consecutive operation 

is started 

by well all consecutive by well operations 

will be executed for a well before moving on 

to the next well 

 

 

 

30. Double-click Dispense in case a reagent addition 

is required prior to the measurement 

Injector select 1, 2 or 3 

Volume 10 to 100 µL 

Speed 1 to 5 

Operation Mode by plate or by well 

31. Click <OK> 

In case additional reagent additions are re-

quired repeat this procedure for the other in-

jector(s) 

 

 

 



LB 942 TriStar² Operating Manual 

 56 

32. Double-click Delay in case an delay/incubation 

time is required 

Duration 0.1 to 3600 s 

Operation Mode by plate or by well 

33. Click <OK> 

 

 

34. Double-click Shake in case shaking is required 

Duration 0.1 to 3600 s 

Speed slow, normal or fast 

Diameter 0.1 to 5 mm 

Type linear, orbital, double-orb. 

Operation Mode by plate or by well 

35. Click <OK> 

 

 

36. Double-click Endpoint in the Luminescence sec-

tion for a luminescence reading 

Name give a (descriptive) name 

Counting Time 0.05 to 600 s 

Emission Filter usually: No Filter 

Note: filters must be defined prior in the Instru-

ment menu 

Operation Mode by plate or by well 

37. Click <OK> 

 

 

 

38. Double-click Endpoint in the Fluorescence sec-

tion for a fluorescence reading 

Name give a (descriptive) name 

Counting Time 0.05 to 600 s 

Lamp Energy 0 to 100 % 

Excitation Filter select from the list 

Emission Filter select from the list 

Note: filters must be defined prior in the Instru-

ment menu 

Operation Mode by plate or by well 

39. Click <OK> 
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40. Double-click Endpoint in the Absorbance section 

for an absorbance reading 

Name give a (descriptive) name 

Counting Time 0.05 to 600 s 

Lamp Energy 0 to 100 % or Auto 

Note: Auto is recommended; it uses the calibrat-

ed energy setting specific for the selected filter 

Excitation Filter select from the list 

Note: filters must be defined prior in the Instru-

ment menu 

Reference Measurement 

Note: the values derived with this filter will be au-

tomatically subtracted from the measurement 

value per well 

Reference Filter select from the list 

Operation Mode by plate or by well 

41. Click <OK> 

 

 

 

42. The sequence of selected operations will be 

displayed on the right-hand side 

Operations can be moved up or down by clicking 

on the operation and dragging them to the re-

spective position 

Operations can be deleted by highlighting and hit-

ting the DEL key or by dragging to the left 

43. Click <Next> 
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44. Define Export settings  

Type your Header specific for this protocol 

 

Select the data set by dragging from left to right 

Sample ID sample information 

Measurement Data readings 

Result calculated data 

Error any error codes 

Overlay well information 

Statistics measurement settings 

 

Type your Footer specific for this protocol 

 

Define Directory for the export file 

 

Check if Automatic Export is required 

 

45. Click <Next> 

 

 

 

46. Define Print settings 

Select the data set by dragging from left to right 

Page Header file names 

Measurement Data readings 

Statistics measurement settings 

Results calculated data 

Overlay well information 

All Curves kinetics curves 

Zoomed Curves zoomed view of curves 

 

Define page orientation and margins 

 

Check if Automatic Print-out is required 

 

47. Click <Next> 

 

 

 

48. Click <Finish> 

 

 



LB 942 TriStar² Operating Manual 

 59 

49. Define the protocol file name 

50. Click <Save> 
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7.2.2 Measurement with a Single Endpoint protocol  
 

The protocol that has been created will be pre-selected. In case you want to perform an-

other measurement you may simply select another protocol from the list. 

 

Note: In case injectors are to be used for reagent additions make sure the injec-

tion lines are properly cleaned and filled (primed). See chapter 8 of this 

manual. 

 

Note: Do not overfill the reagent trough as liquid spills in the injector compart-

ment may cause severe damage to the electrical system. Take special care 

when ice in the trough starts to melt. 

 

Note: Make sure the appropriate plate frame is inserted 

 

1. Select the protocol to be used 

 

 

 

2. Enter a file name under which the measurement 

is to be stored 

 

 

 

3. Click <Start Measurement> 

 

4. Insert the microplate with your samples: 

well A1 facing the rear and left 

Use the black frame for microplates with plate 

heights of 15 mm (±1 mm), e.g. 96 and 384 well 

plates 

Use the red frame for microplates with plate 

heights of 20 mm (±1 mm), e.g. 6, 12, 24 well 

plates 

5. Click <OK> 
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6. The selected wells of the microplate will be 

measured and the numerical value of the signal 

will be displayed 

 

 

7. Select Unload Plate in the Instrument menu to 

retrieve the microplate (still in measurement posi-

tion) and remove it from the instrument 
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7.3 Dual Label Assay measurement  
 

 

A raw data measurement generates pure RLU (or RLU/s) values for each measured well. 

This measurement type is useful in luminescent research assays to determine dual re-

porter gene expression. 

 

7.3.1 Defining a Dual Label protocol  
 

If you want to use an already existing protocol you may proceed with the next paragraph. 

 

1. Click icon Protocol Design in the left-hand Nav-

igation bar 

 

the navigation bar will appear in a new design 

 

 

2. Click the new icon in the left-hand Navigation 

bar 

 

 

 

again, the navigation bar will appear in a new de-

sign 

 

 

 

for editing an existing protocol use the edit icon 

 

 

3. The start up screen of the protocol wizard will 

show up 

Click <Next> 
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4. Enter a (descriptive) Name for your protocol 

5. Define the reading orientation: 

by column or by row 

6. Check Meander to have the instrument read one 

row from the left to right and the consecutive one 

from right to left or one row from top to bottom 

and the consecutive from bottom to top 

7. Check Keep Plate after Measurement in case 

you want the microplate being kept inside the in-

strument after the reading being finished 

8. Check Temperature to activate the temperature 

control for this protocol 

9. Define the target temperature 

the instrument will start to heat the plate com-

partment as soon as the protocol file will be load-

ed 

Robot, Barcode and Multi Plate Data File Mode 

are currently not active 

10. Click <Next> 

 

 

 

11. Select the Plate Type (microplate format) 

 

Note: the microplate has to be defined in the 

Plate Editor prior to defining a protocol 

 

 

 

12. Select the wells to be measured by clicking the 

Measurement radio button 

 for the whole plate, click the top left corner 

 for a row, click the respective character 

 for a column, click the respective number 

 for an area, click and drag the mouse 

 for an individual well, click into it 

Wells with a gray outside area are selected for 

measurement 
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13. Select the wells to be injected into and the re-

spective injector by clicking the Inj 1, Inj 2 or Inj 3 

radio button 

 for the whole plate, click the top left corner 

 for a row, click the respective character 

 for a column, click the respective number 

 for an area, click and drag the mouse 

 for an individual well, click into it 

Wells coloured in the respective colour are inject-

ed into 

Note: only wells to be measured can be injected 

into 

14. Click <Next> 

 

 

 

Define the Measurement Operations 

 Available operations are shown on the left-

hand area 

 Allowed operations are indicated by a check 

mark 

 Double-clicking an operation open the specif-

ic properties dialogue 

 Confirming the settings by clicking <OK> se-

lects the operation and adds it to the opera-

tion sequence visible in the right-hand area 

 The operation may be executed 

by plate the operation will be executed for 

all selected before the consecutive operation 

is started 

by well all consecutive by well operations 

will be executed for a well before moving on 

to the next well 

 

 

 

15. Double-click Dispense in case a reagent addition 

is required prior to the measurement 

Injector select 1, 2 or 3 

Volume 10 to 100 µL 

Speed 1 to 5 

Operation Mode by plate or by well 

16. Click <OK> 

In case additional reagent additions are re-

quired repeat this procedure for the other in-

jector(s) 
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17. Double-click Delay in case an delay/incubation 

time is required 

Duration 0.1 to 3600 s 

Operation Mode by plate or by well 

18. Click <OK> 

 

 

19. Double-click Shake in case shaking is required 

Duration 0.1 to 3600 s 

Speed slow, normal or fast 

Diameter 0.1 to 5 mm 

Type linear, orbital, double-orb. 

Operation Mode by plate or by well 

20. Click <OK> 

 

 

21. Double-click Endpoint, e.g. in the Luminescence 

section for a luminescence reading 

Name give a (descriptive) name 

Counting Time 0.05 to 600 s 

Emission Filter usually: No Filter 

Note: filters must be defined prior in the Instru-

ment menu 

Operation Mode by plate or by well 

22. Click <OK> 

 

 

 

23. Once more double-click Endpoint , e.g. in the 

Luminescence section for a luminescence read-

ing 

Name give a (descriptive) name 

Counting Time 0.05 to 600 s 

Emission Filter usually: No Filter 

Note: filters must be defined prior in the Instru-

ment menu 

Operation Mode by plate or by well 

24. Click <OK> 
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25. The sequence of selected operations will be 

displayed on the right-hand side 

Operations can be moved up or down by clicking 

on the operation and dragging them to the re-

spective position 

Operations can be deleted by highlighting and hit-

ting the DEL key or by dragging to the left 

26. Click <Next> 

 

 

27. Select the calculation to perform with the 2 

measurements 

28. Click <Next> 

 

 

 

29. Define Export settings  

Type your Header specific for this protocol 

 

Select the data set by dragging from left to right 

Sample ID sample information 

Measurement Data readings 

Result calculated data 

Error any error codes 

Overlay well information 

Statistics measurement settings 

 

Type your Footer specific for this protocol 

 

Define Directory for the export file 

 

Check if Automatic Export is required 
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30. Click <Next> 

 

31. Define Print settings 

Select the data set by dragging from left to right 

Page Header file names 

Measurement Data readings 

Statistics measurement settings 

Results calculated data 

Overlay well information 

All Curves kinetics curves 

Zoomed Curves zoomed view of curves 

 

Define page orientation and margins 

 

Check if Automatic Print-out is required 

 

32. Click <Next> 

 

 

 

33. Click <Finish> 

 

 

34. Define the protocol file name 

35. Click <Save> 
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7.3.2 Measurement with a Dual Label Assay protocol  
 

The protocol that has been created will be pre-selected. In case you want to perform a 

measurement you may simply select another protocol from the list. 

 

Note: In case injectors are to be used for reagent additions make sure the injec-

tion lines are properly cleaned and filled (primed). See chapter 8 of this 

manual. 

 

Note: Do not overfill the reagent trough as liquid spills in the injector compart-

ment may cause severe damage to the electrical system. Take special care 

when ice in the trough starts to melt. 

 

Note: Make sure the appropriate plate frame is inserted 

 

1. Select the protocol to be used 

 

 

 

2. Enter a file name under which the measurement 

is to be stored 

 

 

 

3. Click <Start Measurement> 

 

4. Insert the microplate with your samples: 

well A1 facing the rear and left 

Use the black frame for microplates with plate 

heights of 15 mm (±1 mm), e.g. 96 and 384 well 

plates 

Use the red frame for microplates with plate 

heights of 20 mm (±1 mm), e.g. 6, 12, 24 well 

plates 

5. Click <OK> 
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6. The selected wells of the microplate will be 

measured and the numerical value of the signal 

will be displayed 

You may switch between the two readings by 

clicking on the arrows 

 

 

 

 

7. Select Unload Plate in the Instrument menu to 

retrieve the microplate (still in measurement posi-

tion) and remove it from the instrument 
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7.4 Kinetic Measurement  
 

 

A kinetic measurement mode is appropriate for fast kinetics assays lasting over several 

seconds up to minutes, e.g. enzyme kinetics and Calcium influx 

 

 

7.4.1 Defining a protocol for a kinetic measurement  
 

If you want to use an already existing protocol you may proceed with the next paragraph. 

 

1. Click icon Protocol Design in the left-hand Nav-

igation bar 

 

the navigation bar will appear in a new design 

 

 

2. Click the new icon in the left-hand Navigation 

bar 

 

 

 

again, the navigation bar will appear in a new de-

sign 

 

 

 

for editing an existing protocol use the edit icon 

 

 

3. The start up screen of the protocol wizard will 

show up 

Click <Next> 
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4. Enter a (descriptive) Name for your protocol 

5. Define the reading orientation: 

by column or by row 

6. Check Meander to have the instrument read one 

row from the left to right and the consecutive one 

from right to left or one row from top to bottom 

and the consecutive from bottom to top 

7. Check Keep Plate after Measurement in case 

you want the microplate being kept inside the in-

strument after the reading being finished 

8. Check Temperature to activate the temperature 

control for this protocol 

9. Define the target temperature 

the instrument will start to heat the plate com-

partment as soon as the protocol file will be load-

ed 

Robot, Barcode and Multi Plate Data File Mode 

are currently not active 

10. Click <Next> 

 

 

 

11. Select the Plate Type (microplate format) 

 

Note: the microplate has to be defined in the 

Plate Editor prior to defining a protocol 

 

 

 

12. Select the wells to be measured by clicking the 

Measurement radio button 

 for the whole plate, click the top left corner 

 for a row, click the respective character 

 for a column, click the respective number 

 for an area, click and drag the mouse 

 for an individual well, click into it 

Wells with a gray outside area are selected for 

measurement 
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13. Select the wells to be injected into and the re-

spective injector by clicking the Inj 1, Inj 2 or Inj 3 

radio button 

 for the whole plate, click the top left corner 

 for a row, click the respective character 

 for a column, click the respective number 

 for an area, click and drag the mouse 

 for an individual well, click into it 

Wells coloured in the respective colour are inject-

ed into 

Note: only wells to be measured can be injected 

into 

14. Click <Next> 

 

 

 

Define the Measurement Operations 

 Available operations are shown on the left-

hand area 

 Allowed operations are indicated by a check 

mark 

 Double-clicking an operation open the specif-

ic properties dialogue 

 Confirming the settings by clicking <OK> se-

lects the operation and adds it to the opera-

tion sequence visible in the right-hand area 

 The operation may be executed 

by plate the operation will be executed for 

all selected before the consecutive operation 

is started 

by well all consecutive by well operations 

will be executed for a well before moving on 

to the next well 

 

 

 

15. Double-click Dispense in case a reagent addition 

is required prior to the measurement 

Injector select 1, 2 or 3 

Volume 10 to 100 µL 

Speed 1 to 5 

Operation Mode by plate or by well 

16. Click <OK> 

In case additional reagent additions are re-

quired repeat this procedure for the other in-

jector(s) 
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17. Double-click Delay in case an delay/incubation 

time is required 

Duration 0.1 to 3600 s 

Operation Mode by plate or by well 

18. Click <OK> 

 

 

19. Double-click Shake in case shaking is required 

Duration 0.1 to 3600 s 

Speed slow, normal or fast 

Diameter 0.1 to 5 mm 

Type linear, orbital, double-orb. 

Operation Mode by plate or by well 

20. Click <OK> 

 

 

21. Double-click Kinetic in the Luminescence section 

for a luminescence kinetic reading 

Name give a (descriptive) name 

Total Time the entire kinetic time (max. 

7 days) 

Counting Time 0.05 to 600 s 

Check Use Shake instead of Delay if needed 

Delay 0 to 600 sec 

Repeats (are calculated) 

Emission Filter usually: No Filter 

Note: filters must be defined prior in the Instru-

ment menu 

Second Measurement may be checked in case of 

ratiometric kinetics, e.g. in BRET applications 

22. Click <OK> 

 

a second or third kinetic operation may be added, 

e.g. after a dispensing operation, and set up in 

the same way 
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23. Double-click Kinetic in the Fluorescence section 

for a fluorescence kinetic reading 

Name give a (descriptive) name 

Total Time the entire kinetic time (max. 

7 days) 

Counting Time 0.05 to 600 s 

Check Use Shake instead of Delay if needed 

Delay 0 to 600 s 

Repeats (are calculated) 

Lamp Energy 0 to 100 % 

Excitation Filter select from the list 

Emission Filter select from the list 

Note: filters must be defined prior in the Instru-

ment menu 

Operation Mode by plate or by well 

Second Measurement may be checked in case of 

ratiometric kinetics, e.g. in Calcium applications 

24. Click <OK> 

 

a second or third kinetic operation may be added, 

e.g. after a dispensing operation, and set up in 

the same way 

 

 

 

25. Double-click Kinetic in the Absorbance section 

for an absorbance kinetic reading 

Name give a (descriptive) name 

Total Time the entire kinetic time (max. 

7 days) 

Counting Time 0.05 to 600 s 

Check Use Shake instead of Delay if needed 

Delay 0 to 600 s 

Repeats (are calculated) 

Lamp Energy 0 to 100 % or Auto 

Note: Auto is recommended; it uses the calibrat-

ed energy setting specific for the selected filter 

Measurement Filter select from the list 

Note: filters must be defined prior in the Instru-

ment menu 

26. Click <OK> 

 

a second or third kinetic operation may be added, 

e.g. after a dispensing operation, and set up in 

the same way 
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27. The sequence of selected operations will be 

displayed on the right-hand side 

Operations can be moved up or down by clicking 

on the operation and dragging them to the re-

spective position 

Operations can be deleted by highlighting and hit-

ting the DEL key or by dragging to the left 

28. Click <Next> 

 

 

29. Define Export settings  

Type your Header specific for this protocol 

 

Select the data set by dragging from left to right 

Sample ID sample information 

Measurement Data readings 

Result calculated data 

Error any error codes 

Overlay well information 

Statistics measurement settings 

 

Type your Footer specific for this protocol 

 

Define Directory for the export file 

 

Check if Automatic Export is required 

 

30. Click <Next> 
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31. Define Print settings 

Select the data set by dragging from left to right 

Page Header file names 

Measurement Data readings 

Statistics measurement settings 

Results calculated data 

Overlay well information 

All Curves kinetics curves 

Zoomed Curves zoomed view of curves 

 

Define page orientation and margins 

 

Check if Automatic Print-out is required 

 

32. Click <Next> 

 

 

 

33. Click <Finish> 

 

 

34. Define the protocol file name 

35. Click <Save> 
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7.4.2 Kinetic measurement  
 

The protocol that has been created will be pre-selected. In case you want to perform a 

measurement you may simply select another protocol from the list. 

 

Note: In case injectors are to be used for reagent additions make sure the injec-

tion lines are properly cleaned and filled (primed). See chapter 8 of this 

manual. 

 

Note: Do not overfill the reagent trough as liquid spills in the injector compart-

ment may cause severe damage to the electrical system. Take special care 

when ice in the trough starts to melt. 

 

Note: Make sure the appropriate plate frame is inserted 

 

8. Select the protocol to be used 

 

 

 

9. Enter a file name under which the measurement 

is to be stored 

 

 

 

10. Click <Start Measurement> 

 

11. Insert the microplate with your samples: 

well A1 facing the rear and left 

Use the black frame for microplates with plate 

heights of 15 mm (±1 mm), e.g. 96 and 384 well 

plates 

Use the red frame for microplates with plate 

heights of 20 mm (±1 mm), e.g. 6, 12, 24 well 

plates 

12. Click <OK> 
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13. The selected wells of the microplate will be 

measured and the numerical value of the signal 

will be displayed 

You may switch between the individual readings 

by clicking on the arrows 

 

 

 

 

14. You also choose to view the curves by clicking 

the Kinetics tab 

15. The scale of the axes can be changed by right-

clicking into the curves and selecting Options… 

 

 

 

 

16. To get a zoomed view click into the respective 

wells to highlight them, then right-click and select 

Zoomed Curves 

 

 

To un-zoom right-click into the zoomed view and 

select All Curves 
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17. Select Unload Plate in the Instrument menu to 

retrieve the microplate (still in measurement posi-

tion) and remove it from the instrument 
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7.5 Repeated Measurement  
 

 

A repeated measurement mode is appropriate for long-term kinetic assays lasting over 

multiple minutes up to several days, e.g. cellular luminescence, slow enzyme kinetics, 

long-term gene expression or growth monitoring 

 

7.5.1 Defining a protocol for a repeated measurement  
 

If you want to use an already existing protocol you may proceed with the next paragraph. 

 

1. Click icon Protocol Design in the left-hand Nav-

igation bar 

 

the navigation bar will appear in a new design 

 

 

2. Click the new icon in the left-hand Navigation 

bar 

 

 

 

again, the navigation bar will appear in a new de-

sign 

 

 

 

for editing an existing protocol use the edit icon 

 

 

3. The start up screen of the protocol wizard will 

show up 

Click <Next> 
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4. Enter a (descriptive) Name for your protocol 

5. Define the reading orientation: 

by column or by row 

6. Check Meander to have the instrument read one 

row from the left to right and the consecutive one 

from right to left or one row from top to bottom 

and the consecutive from bottom to top 

7. Check Keep Plate after Measurement in case 

you want the microplate being kept inside the in-

strument after the reading being finished 

8. Check Temperature to activate the temperature 

control for this protocol 

9. Define the target temperature 

the instrument will start to heat the plate com-

partment as soon as the protocol file will be load-

ed 

Robot, Barcode and Multi Plate Data File Mode 

are currently not active 

10. Click <Next> 

 

 

 

11. Select the Plate Type (microplate format) 

 

Note: the microplate has to be defined in the 

Plate Editor prior to defining a protocol 

 

 

 

12. Select the wells to be measured by clicking the 

Measurement radio button 

 for the whole plate, click the top left corner 

 for a row, click the respective character 

 for a column, click the respective number 

 for an area, click and drag the mouse 

 for an individual well, click into it 

Wells with a gray outside area are selected for 

measurement 
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13. Select the wells to be injected into and the re-

spective injector by clicking the Inj 1, Inj 2 or Inj 3 

radio button 

 for the whole plate, click the top left corner 

 for a row, click the respective character 

 for a column, click the respective number 

 for an area, click and drag the mouse 

 for an individual well, click into it 

Wells coloured in the respective colour are inject-

ed into 

Note: only wells to be measured can be injected 

into 

14. Click <Next> 

 

 

 

Define the Measurement Operations 

 Available operations are shown on the left-

hand area 

 Allowed operations are indicated by a check 

mark 

 Double-clicking an operation open the specif-

ic properties dialogue 

 Confirming the settings by clicking <OK> se-

lects the operation and adds it to the opera-

tion sequence visible in the right-hand area 

 The operation may be executed 

by plate the operation will be executed for 

all selected before the consecutive operation 

is started 

by well all consecutive by well operations 

will be executed for a well before moving on 

to the next well 

 

 

 

15. Double-click Dispense in case a reagent addition 

is required prior to the measurement 

Injector select 1, 2 or 3 

Volume 10 to 100 µL 

Speed 1 to 5 

Operation Mode by plate or by well 

16. Click <OK> 

In case additional reagent additions are re-

quired repeat this procedure for the other in-

jector(s) 
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17. Double-click Delay in case an delay/incubation 

time is required 

Duration 0.1 to 3600 s 

Operation Mode by plate or by well 

18. Click <OK> 

 

 

19. Double-click Shake in case shaking is required 

Duration 0.1 to 3600 s 

Speed slow, normal or fast 

Diameter 0.1 to 5 mm 

Type linear, orbital, double-orb. 

Operation Mode by plate or by well 

20. Click <OK> 

 

 

21. Double-click Repeated in the Luminescence sec-

tion for a luminescence repeated reading 

Name give a (descriptive) name 

Total Time the entire kinetic time (max. 

7 days) 

Counting Time 0.05 to 600 s 

Cycle Time the time a specific well is 

read again in the consecu-

tive cycle 

Repeats (are calculated) 

Emission Filter usually: No Filter 

Note: filters must be defined prior in the Instru-

ment menu 

Injector 1, …2, …3 

Check Use Injector for an injection within the re-

peated cycle 

Injector Cycle 0 means prior to a meas-

urement 

Volume 10 to 100 µL 

Speed 1 to 5 

Operation Mode by plate or by well 

22. Click <OK> 

 

a second repeated operation may be added, e.g. 

for ratiometric applications (BRET) 
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23. Double-click Repeated in the Fluorescence sec-

tion for a fluorescence repeated reading 

Name give a (descriptive) name 

Total Time the entire kinetic time (max. 

7 days) 

Counting Time 0.05 to 600 s 

Cycle Time the time a specific well is 

read again in the consecu-

tive cycle 

Repeats (are calculated) 

Lamp Energy 0 to 100 % 

Excitation Filter select from the list 

Emission Filter select from the list 

Note: filters must be defined prior in the Instru-

ment menu 

Injector 1, …2, …3 

Check Use Injector for an injection within the re-

peated cycle 

Injector Cycle 0 means prior to a meas-

urement 

Volume 10 to 100 µL 

Speed 1 to 5 

Operation Mode by plate or by well 

24. Click <OK> 

 

a second repeated operation may be added, e.g. 

for ratiometric applications (FRET) 
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25. Double-click Repeated in the Absorbance section 

for a absorbance repeated reading 

Name give a (descriptive) name 

Total Time the entire kinetic time (max. 

7 days) 

Counting Time 0.05 to 600 s 

Cycle Time the time a specific well is 

read again in the consecu-

tive cycle 

Repeats (are calculated) 

Lamp Energy 0 to 100 % or Auto 

Note: Auto is recommended; it uses the calibrat-

ed energy setting specific for the selected filter 

Measurement Filter select from the list 

Check Reference Measurement if needed 

Reference Filter select from the list 

Note: filters must be defined prior in the Instru-

ment menu 

Injector 1, …2, …3 

Check Use Injector for an injection within the re-

peated cycle 

Injector Cycle 0 means prior to a meas-

urement 

Volume 10 to 100 µL 

Speed 1 to 5 

Operation Mode by plate or by well 

26. Click <OK> 

 

a second repeated operation may be added, e.g. 

for ratiometric applications 
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27. The sequence of selected operations will be 

displayed on the right-hand side 

Operations can be moved up or down by clicking 

on the operation and dragging them to the re-

spective position 

Operations can be deleted by highlighting and hit-

ting the DEL key or by dragging to the left 

28. Click <Next> 

 

 

29. Define Export settings  

Type your Header specific for this protocol 

 

Select the data set by dragging from left to right 

Sample ID sample information 

Measurement Data readings 

Result calculated data 

Error any error codes 

Overlay well information 

Statistics measurement settings 

 

Type your Footer specific for this protocol 

 

Define Directory for the export file 

 

Check if Automatic Export is required 

 

30. Click <Next> 
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31. Define Print settings 

Select the data set by dragging from left to right 

Page Header file names 

Measurement Data readings 

Statistics measurement settings 

Results calculated data 

Overlay well information 

All Curves kinetics curves 

Zoomed Curves zoomed view of curves 

 

Define page orientation and margins 

 

Check if Automatic Print-out is required 

 

32. Click <Next> 

 

 

 

33. Click <Finish> 

 

 

34. Define the protocol file name 

35. Click <Save> 
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7.5.2 Repeated measurement  
 

The protocol that has been created will be pre-selected. In case you want to perform a 

measurement you may simply select another protocol from the list. 

 

Note: In case injectors are to be used for reagent additions make sure the injec-

tion lines are properly cleaned and filled (primed). See chapter 8 of this 

manual. 

 

Note: Do not overfill the reagent trough as liquid spills in the injector compart-

ment may cause severe damage to the electrical system. Take special care 

when ice in the trough starts to melt. 

 

Note: Make sure the appropriate plate frame is inserted 

 

1. Select the protocol to be used 

 

 

 

2. Enter a file name under which the measurement 

is to be stored 

 

 

 

3. Click <Start Measurement> 

 

4. Insert the microplate with your samples: 

well A1 facing the rear and left 

Use the black frame for microplates with plate 

heights of 15 mm (±1 mm), e.g. 96 and 384 well 

plates 

Use the red frame for microplates with plate 

heights of 20 mm (±1 mm), e.g. 6, 12, 24 well 

plates 

5. Click <OK> 
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6. The selected wells of the microplate will be 

measured and the numerical value of the signal 

will be displayed 

You may switch between the individual readings 

by clicking on the arrows 

 

 

 

 

7. You also choose to view the curves by clicking 

the Repeated tab 

8. The scale of the axes can be changed by right-

clicking into the curves and selecting Options… 

 

 

 

 

9. To get a zoomed view click into the respective 

wells to highlight them, then right-click and select 

Zoomed Curves 

 

 

To un-zoom right-click into the zoomed view and 

select All Curves 
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10. Select Unload Plate in the Instrument menu to 

retrieve the microplate (still in measurement posi-

tion) and remove it from the instrument 
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7.6 Scanning Measurement  
 

 

A scanning measurement mode is appropriate for assays with heterogeneous distribution 

of signal, e.g. cellular assays 

 

7.6.1 Defining a protocol for a scanning measurement  
 

If you want to use an already existing protocol you may proceed with the next paragraph. 

 

1. Click icon Protocol Design in the left-hand Nav-

igation bar 

 

the navigation bar will appear in a new design 

 

 

2. Click the new icon in the left-hand Navigation 

bar 

 

 

 

again, the navigation bar will appear in a new de-

sign 

 

 

 

for editing an existing protocol use the edit icon 

 

 

3. The start up screen of the protocol wizard will 

show up 

Click <Next> 
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4. Enter a (descriptive) Name for your protocol 

5. Define the reading orientation: 

by column or by row 

6. Check Meander to have the instrument read one 

row from the left to right and the consecutive one 

from right to left or one row from top to bottom 

and the consecutive from bottom to top 

7. Check Keep Plate after Measurement in case 

you want the microplate being kept inside the in-

strument after the reading being finished 

8. Check Temperature to activate the temperature 

control for this protocol 

9. Define the target temperature 

the instrument will start to heat the plate com-

partment as soon as the protocol file will be load-

ed 

Robot, Barcode and Multi Plate Data File Mode 

are currently not active 

10. Click <Next> 

 

 

 

11. Select the Plate Type (microplate format) 

 

Note: the microplate has to be defined in the 

Plate Editor prior to defining a protocol 

 

 

 

12. Select the wells to be measured by clicking the 

Measurement radio button 

 for the whole plate, click the top left corner 

 for a row, click the respective character 

 for a column, click the respective number 

 for an area, click and drag the mouse 

 for an individual well, click into it 

Wells with a gray outside area are selected for 

measurement 
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13. Select the wells to be injected into and the re-

spective injector by clicking the Inj 1, Inj 2 or Inj 3 

radio button 

 for the whole plate, click the top left corner 

 for a row, click the respective character 

 for a column, click the respective number 

 for an area, click and drag the mouse 

 for an individual well, click into it 

Wells coloured in the respective colour are inject-

ed into 

Note: only wells to be measured can be injected 

into 

14. Click <Next> 

 

 

 

Define the Measurement Operations 

 Available operations are shown on the left-

hand area 

 Allowed operations are indicated by a check 

mark 

 Double-clicking an operation open the specif-

ic properties dialogue 

 Confirming the settings by clicking <OK> se-

lects the operation and adds it to the opera-

tion sequence visible in the right-hand area 

 The operation may be executed 

by plate the operation will be executed for 

all selected before the consecutive operation 

is started 

by well all consecutive by well operations 

will be executed for a well before moving on 

to the next well 

 

 

 

15. Double-click Dispense in case a reagent addition 

is required prior to the measurement 

Injector select 1, 2 or 3 

Volume 10 to 100 µL 

Speed 1 to 5 

Operation Mode by plate or by well 

16. Click <OK> 

In case additional reagent additions are re-

quired repeat this procedure for the other in-

jector(s) 
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17. Double-click Delay in case an delay/incubation 

time is required 

Duration 0.1 to 3600 s 

Operation Mode by plate or by well 

18. Click <OK> 

 

 

19. Double-click Shake in case shaking is required 

Duration 0.1 to 3600 s 

Speed slow, normal or fast 

Diameter 0.1 to 5 mm 

Type linear, orbital, double-orb. 

Operation Mode by plate or by well 

20. Click <OK> 

 

 

21. Double-click Scanning in the Fluorescence sec-

tion for a fluorescence scanning reading 

Name give a (descriptive) name 

Counting Time 0.05 to 600 s 

Lamp Energy 0 to 100 % 

Excitation Filter select from the list 

Emission Filter select from the list 

Note: filters must be defined prior in the Instru-

ment menu 

Steps 1 to 100 

scanning points in one di-

rection, the other direction 

will have the same amount 

of points 

Point Displacement distance between points 

Select rectangular or round matrix 

22. Click <OK> 
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23. Double-click Scanning in the Absorbance section 

for a absorbance scanning reading 

Name give a (descriptive) name 

Counting Time 0.05 to 600 s 

Lamp Energy 0 to 100 % or Auto 

Note: Auto is recommended; it uses the calibrat-

ed energy setting specific for the selected filter 

Measurement Filter select from the list 

Note: filters must be defined prior in the Instru-

ment menu 

Steps 1 to 100 

scanning points in one di-

rection, the other direction 

will have the same amount 

of points 

Point Displacement distance between points 

Select rectangular or round matrix 

24. Click <OK> 

 

 

 

25. The sequence of selected operations will be 

displayed on the right-hand side 

Operations can be moved up or down by clicking 

on the operation and dragging them to the re-

spective position 

Operations can be deleted by highlighting and hit-

ting the DEL key or by dragging to the left 

26. Click <Next> 
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27. Define Export settings  

Type your Header specific for this protocol 

 

Select the data set by dragging from left to right 

Sample ID sample information 

Measurement Data readings 

Result calculated data 

Error any error codes 

Overlay well information 

Statistics measurement settings 

 

Type your Footer specific for this protocol 

 

Define Directory for the export file 

 

Check if Automatic Export is required 

 

28. Click <Next> 

 

 

 

29. Define Print settings 

Select the data set by dragging from left to right 

Page Header file names 

Measurement Data readings 

Statistics measurement settings 

Results calculated data 

Overlay well information 

All Curves kinetics curves 

Zoomed Curves zoomed view of curves 

 

Define page orientation and margins 

 

Check if Automatic Print-out is required 

 

30. Click <Next> 

 

 

 

31. Click <Finish> 
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32. Define the protocol file name 

33. Click <Save> 
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7.6.2 Scanning measurement  
 

The protocol that has been created will be pre-selected. In case you want to perform a 

measurement you may simply select another protocol from the list. 

 

Note: In case injectors are to be used for reagent additions make sure the injec-

tion lines are properly cleaned and filled (primed). See chapter 8 of this 

manual. 

 

Note: Do not overfill the reagent trough as liquid spills in the injector compart-

ment may cause severe damage to the electrical system. Take special care 

when ice in the trough starts to melt. 

 

Note: Make sure the appropriate plate frame is inserted 

 

1. Select the protocol to be used 

 

 

 

2. Enter a file name under which the measurement 

is to be stored 

 

 

 

3. Click <Start Measurement> 

 

4. Insert the microplate with your samples: 

well A1 facing the rear and left 

Use the black frame for microplates with plate 

heights of 15 mm (±1 mm), e.g. 96 and 384 well 

plates 

Use the red frame for microplates with plate 

heights of 20 mm (±1 mm), e.g. 6, 12, 24 well 

plates 

5. Click <OK> 
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6. The selected wells of the microplate will be 

measured and the numerical value of the signal 

will be displayed 

You may switch between the individual readings 

by clicking on the arrows 

 

 

 

 

7. You also choose to view a graphical display by 

clicking the Scanning tab 

 

 

 

8. To get a zoomed view click into the respective 

wells to highlight them, then right-click and select 

Zoomed Areas 

 

 

To un-zoom right-click into the zoomed view and 

select All Curves 
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9. Select Unload Plate in the Instrument menu to 

retrieve the microplate (still in measurement posi-

tion) and remove it from the instrument 
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7.7 Data export and print-out  
 

 

7.7.1 Direct data export  
 

1. Click on Save Data File As…  in the File menu 

 

 

2. Select the file format, e.g. Excel files (*.xls) 

3. Define the file name without extension 

4. Select the appropriate folder 

5. Click <Save> 
 

 

6. Open the *.xls file 

 

 

 

The export will be executed automatically if selected in the respective protocol file. 
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7.7.2 Data export via Export  
 

1. Click on Export  in the File menu 

2. An EXCEL file will be created with file name re-

sembling that of the data file 

 

 

3. Open the *.xls file 

 

 

 

The export will be executed automatically if selected in the respective protocol file. 
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7.7.3 Direct data print-out  
 

1. If not opened already open the respective data 

file by selecting Open Data File in the File menu 

 

 

2. Select Print Preview  in the File menu to get a 

preview of the print-out 

3. Select Print in the File menu to start printing the 

data 

 

 

The print-out will be executed automatically if selected in the respective protocol file. 
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8. Operation with Mikrowin 2000 
 

 

Running measurements on the TriStar² is straight forward. The procedure is the same for all types 

of assay types, e.g. Raw Data, Dual Label, Kinetic, Repeated and Scanning. A measurement can 

be carried out immediately after a stored protocol is selected. At the end of each measurement the 

results are stored and may be printed or exported. 

Result file names can be given without limitation. The extension is fixed, though. This is valid for 

measurement protocols as well. 

 

 

8.1 Adding and Editing Microplate Dimensions  
 

 

Microplates can differ in their dimensions dependent on brand and type. Please refer to 

the manufacturer´s most recent information for exact dimensions of the microplates. 

 

Microplates must be defined in the plate editor prior to defining a measurement protocol. 

 

51. Click Plate Editor in the Instrument menu 

 

 

 

52. Click <New Plate> or select a plate with match-

ing well format and click <Copy> 
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53. Assign a (descriptive) Name 

54. Insert the Number of rows, e.g. 8 for a 96 well 

plate 

55. Insert the Number of columns, e.g. 12 for a 96 

well plate 

56. Insert the total Height of the microplate 

most 96 and 384 well plates are between 14 and 15.5 

mm 

57. Insert the Stacking height of the microplate 

the stacking height is the resulting height (the visible 

part) when plates are put on top of each other (e.g. in a 

plate stacker) 

in case this information is not available from the plate 

manufacturer the stacking height can be derived by 

stacking 2 plates and measuring the total height; by 

subtracting the regular height of one of the plates the 

resulting value will be the stacking height 

58. Insert the distance between the left outer edge of 

the plate and the center of well A1 

59. Insert the distance between to upper outer edge 

of the plate and the center of well A1 

60. Insert the distance between the well centers of 

consecutive rows (vertical well distance) 

61. Insert the distance between the well centers of 

consecutive columns (horizontal well distance) 

62. Check the usage TriStar2 

you may check additional instruments in case you have 

multiple instruments in operation 

63. Click <Apply> 

64. Click <OK> 

 

 

 

65. The plate can now be used in the protocol files 
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8.2 Single Raw Data measurement  
 

 

A raw data measurement generates pure RLU (or RLU/s) values for each measured well. 

This measurement type is useful in luminescent research assays to determine ATP con-

tent, single reporter gene expression, activities of caspases, kinases and many other en-

zymes. 

 

8.2.1 Defining a Single Endpoint protocol  
 

If you want to use an already existing protocol you may proceed with the next paragraph. 

 

1. Click Read in the Options menu 

 

2. Select BertholdTech TriStar2 
 

3. Click <Settings> 
 

 
 

 

4. Select the Plate Type (microplate format) 

 

Note: the microplate has to be defined in the 

Plate Editor prior to defining a protocol 

5. Define the reading orientation: 

by columns or by rows 

6. Check Meander to have the instrument read one 

row from the left to right and the consecutive one 

from right to left or one row from top to bottom 

and the consecutive from bottom to top 
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7. Select the wells to be measured by clicking the 

Measurement radio button 

 for the whole plate, click the top left corner 

 for a row, click the respective character 

 for a column, click the respective number 

 for an area, click and drag the mouse 

 for an individual well, click into it 

Wells with a gray outside area are selected for 

measurement 

 

 

 

8. Select the wells to be injected into and the re-

spective injector by clicking the Inj 1, Inj 2 or Inj 3 

radio button 

 for the whole plate, click the top left corner 

 for a row, click the respective character 

 for a column, click the respective number 

 for an area, click and drag the mouse 

 for an individual well, click into it 

Wells coloured in the respective colour are inject-

ed into 

Note: only wells to be measured can be injected 

into 
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9. Click onto the Measurement tab 

Define the Measurement Operations 

 Available operations are shown on the left-

hand area 

 Allowed operations are indicated by a check 

mark 

 Double-clicking an operation open the specif-

ic properties dialogue 

 Confirming the settings by clicking <OK> se-

lects the operation and adds it to the opera-

tion sequence visible in the right-hand area 

 The operation may be executed 

by plate the operation will be executed for 

all selected before the consecutive operation 

is started 

by well all consecutive by well operations 

will be executed for a well before moving on 

to the next well 

 

 

 

10. Double-click Dispense in case a reagent addition 

is required prior to the measurement 

Injector select 1, 2 or 3 

Volume 10 to 100 µL 

Speed low – middle - high 

Operation Mode by plate or by well 

11. Click <OK> 

In case additional reagent additions are re-

quired repeat this procedure for the other in-

jector(s) 

 

 

 

12. Double-click Delay in case an delay/incubation 

time is required 

Duration 0.1 to 3600 s 

Operation Mode by plate or by well 

13. Click <OK> 
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14. Double-click Shake in case shaking is required 

Duration 0.1 to 3600 s 

Speed slow, normal or fast 

Diameter 0.1 to 5 mm 

Type linear, orbital, double-orb. 

Operation Mode by plate or by well 

15. Click <OK> 

 

 

16. Double-click Lumin.Label for a luminescence 

reading 

Name give a (descriptive) name 

Counting Time 0.05 to 600 s 

Emission Filter usually: No Filter 

Note: filters must be defined prior in the Instru-

ment menu 

Operation Mode by plate or by well 

17. Click <OK> 

 

 

 

18. Double-click Fluor. Label for a fluorescence 

reading 

Name give a (descriptive) name 

Counting Time 0.05 to 600 s 

Lamp Energy 0 to 100 % 

Excitation Filter select from the list 

Emission Filter select from the list 

Note: filters must be defined prior in the Instru-

ment menu 

Operation Mode by plate or by well 

19. Click <OK> 

 

 

20. Double-click Absorbance for an absorbance 

reading 

Name give a (descriptive) name 

Counting Time 0.05 to 600 s 

Lamp Energy 0 to 100 % or Auto 

Note: Auto is recommended; it uses the calibrat-

ed energy setting specific for the selected filter 

Excitation Filter select from the list 

Note: filters must be defined prior in the Instru-

ment menu 

Reference Measurement 
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Note: the values derived with this filter will be au-

tomatically subtracted from the measurement 

value per well 

Reference Filter select from the list 

Operation Mode by plate or by well 

21. Click <OK> 

 

 

22. The sequence of selected operations will be 

displayed in the center column 

Operations can be moved up or down by high-

lighting the operation and clicking on the respec-

tive arrow 

Operations can be deleted by highlighting and 

clicking the cross 

Details of the operation highlighted can be viewed 

on the right column 

An operation can be edited by double-clicking on 

it in the center column 

 

23. Check Batch and define the number of plates in 

Plate Repeats in case you want a number of 

plates to be stored into a single data file 

Note: this setting can only be used in single 

endpoint measurements 

 

24. Define a number in Plate Repeats only in case 

you want the selected operations to be repeatedly 

executed 

 

25. Check Temperature to activate the temperature 

control for this protocol 

26. Define the target temperature 

the instrument will start to heat the plate com-

partment as soon as the protocol file will be load-

ed 

Robot, Barcode and Multi Plate Data File Mode 

are currently not active 

 

27. Check Keep Plate after Measurement in case 

you want the microplate being kept inside the in-

strument after the reading being finished 

 

28. Click <OK> 

 

29. Click <OK> once more 

 

 



LB 942 TriStar² Operating Manual 

 111 

30. By default the plain measurement data will be lo-

cated on Result matrix 2 “Reader_Values” 

For export und print you have to refer to this ma-

trix. 

Should you wish to define any additional calcula-

tions please refer to the Mikrowin manual. 

 

 

 

31. To activate automatic export click Export Set-

up… in the File menu 

32. Select the appropriate and pre-defined export 

driver 

 

The export drivers and their setup are ex-

plained in a later chapter. Please refer to this 

chapter for the proper configuration of the 

export driver. 

 

33. Click <OK> 

 

 

 

34. Click Print Setup… in the File menu 

35. Select the data set by highlighting and clicking 

<Add> 

Page Header header part 

File Names par and dat files names 

Measurement Data raw data 

Sample ID sample info (matrix1)* 

Reader_Values measured data (matrix 2)* 

Results Averages (matrix 3)* 

Gen. Statistics measurement settings 

 

* the selection and content depends on the matrix 

definition done in the Calculation section 

 

36. Check if Automatic Print-out is required 

 

 

 

37. Type a header and/or footer 

 

 

 

 

38. Click <OK> 
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39. Go to File | Save As… 

40. Create and/or Select an appropriate directory, 

e.g. ParaTriStar2 

41. Select the file type Mikrowin Para File (*.par) 

42. Type a meaningful file name 

43. Click <Save> 
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8.2.2 Measurement with a Single Endpoint protocol  
 

The protocol that has been created will be pre-selected. In case you want to perform an-

other measurement you may simply select another protocol from the list. 

 

Note: In case injectors are to be used for reagent additions make sure the injec-

tion lines are properly cleaned and filled (primed). See chapter 9 of this 

manual. 

 

Note: Do not overfill the reagent trough as liquid spills in the injector compart-

ment may cause severe damage to the electrical system. Take special care 

when ice in the trough starts to melt. 

 

Note: Make sure the appropriate plate frame is inserted 

 

1. Click Open in the File menu 

2. Select File of type: Mikrowin Para File 

3. Select the appropriate file 

4. Click <Open> 

 

 

 

5. Enter a file name under which the measurement 

is to be stored 

 

 

 

6. Click <Start> 

 

 

7. Insert the microplate with your samples: 

well A1 facing the rear and left 

Use the black frame for microplates with plate 

heights of 15 mm (±1 mm), e.g. 96 and 384 well 

plates 

Use the red frame for microplates with plate 

heights of 20 mm (±1 mm), e.g. 6, 12, 24 well 

plates 

8. Click <OK> 
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9. The selected wells of the microplate will be 

measured and the numerical value of the signal 

will be displayed 

 

 

10. Select Unload Plate in the Instrument menu to 

retrieve the microplate (still in measurement posi-

tion) and remove it from the instrument 
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8.3 Dual Label Assay measurement  
 

 

A raw data measurement generates pure RLU (or RLU/s) values for each measured well. 

This measurement type is useful in luminescent research assays to determine dual re-

porter gene expression. 

 

8.3.1 Defining a Dual Label protocol  
 

Follow the instructions until step 15 as described in paragraph 8.2.1 for a single endpoint 

measurement. 

 

If you want to use an already existing protocol you may proceed with the next paragraph. 

 

16. Double-click Lumin.Label for a luminescence 

reading 

Name give a (descriptive) name 

Counting Time 0.05 to 600 s 

Emission Filter usually: No Filter 

Note: filters must be defined prior in the Instru-

ment menu 

Operation Mode by plate or by well 

17. Double-click Lumin.Label once more and define 

the settings for the second reading 

 

For very fast switch between the first and the 

second reading, e.g. for fast BRET kinetics or for 

ratiometric readings monitoring fast reaction ki-

netics you may check Second Measurement in-

stead of defining a second label 

 

You may define additional operations, e.g. Dis-

pense, Delay or Shaking in between the two 

measurement operations, e.g. in DLR assays 

 

18. Click <OK> 
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19. Double-click Fluor. Label for a fluorescence 

reading 

Name give a (descriptive) name 

Counting Time 0.05 to 600 s 

Lamp Energy 0 to 100 % 

Excitation Filter select from the list 

Emission Filter select from the list 

Note: filters must be defined prior in the Instru-

ment menu 

Operation Mode by plate or by well 

20. Double-click Fluor.Label once more and define 

the settings for the second reading 

 

For very fast switch between the first and the 

second reading, e.g. for fast BRET kinetics or for 

ratiometric readings monitoring fast reaction ki-

netics you may check Second Measurement in-

stead of defining a second label 

 

You may define additional operations, e.g. Dis-

pense, Delay or Shaking in between the two 

measurement operations, e.g. in DLR assays 

 

21. Click <OK> 

 

 

22. Double-click Absorbance for an absorbance 

reading 

Name give a (descriptive) name 

Counting Time 0.05 to 600 s 

Lamp Energy 0 to 100 % or Auto 

Note: Auto is recommended; it uses the calibrat-

ed energy setting specific for the selected filter 

Excitation Filter select from the list 

Note: filters must be defined prior in the Instru-

ment menu 

Reference Measurement 

Note: the values derived with this filter will be au-

tomatically subtracted from the measurement 

value per well 

Reference Filter select from the list 

Operation Mode by plate or by well 

23. Double-click Absorbance once more and define 

the settings for the second reading 

 

For very fast switch between the first and the 

second reading, e.g. for fast BRET kinetics or for 
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ratiometric readings monitoring fast reaction ki-

netics you may check Second Measurement in-

stead of defining a second label 

 

You may define additional operations, e.g. Dis-

pense, Delay or Shaking in between the two 

measurement operations, e.g. in DLR assays 

 

24. Click <OK> 

 

25. The sequence of selected operations will be 

displayed in the center column 

Operations can be moved up or down by high-

lighting the operation and clicking on the respec-

tive arrow 

Operations can be deleted by highlighting and 

clicking the cross 

Details of the operation highlighted can be viewed 

on the right column 

An operation can be edited by double-clicking on 

it in the center column 

 

26. Do not check Batch 

Note: this setting can only be used in single 

endpoint measurements 

 

27. Define a number in Plate Repeats only in case 

you want the selected operations to be repeatedly 

executed 

 

28. Check Temperature to activate the temperature 

control for this protocol 

29. Define the target temperature 

the instrument will start to heat the plate com-

partment as soon as the protocol file will be load-

ed 

Robot, Barcode and Multi Plate Data File Mode 

are currently not active 

 

30. Check Keep Plate after Measurement in case 

you want the microplate being kept inside the in-

strument after the reading being finished 

 

31. Click <OK> 

 

32. Click <OK> once more 
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For further calculations of the measurements fol-

low the next steps: 

33. Go to Options | Matrix and click <Add Matrix> 

34. Highlight Matrix No. 2, click <Edit Matrix> and 

rename to e.g. first reading 

Do the same for Matrix No. 3 (rename to e.g. 

second reading) and Matrix No. 4 (rename to 

e.g. ratio) 

35. Click <OK> 

 

For export und print you have to refer to this ma-

trices. 

 

 

 

36. Change the view to the Calculation section 

37. Click on the 2 first reading tab 

38. Type LB1 into the Calculation Formula: 

LB1 = Label 1 = first of readings 

39. Click the double-cross to assign for all wells 

 

40. Proceed with the two other matrices alike: 

3 second reading LB2 

LB 2 = Label 2 = second of readings 

4 ratio MA2/MA3 

MA2 = Matrix 2, MA3 = Matrix 3, MA2/MA3 = val-

ues of Matrix 2 divided by values of Matrix 3 

 

Should you wish to define any additional calcula-

tions please refer to the Mikrowin manual. 
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41. To activate automatic export click Export Set-

up… in the File menu 

42. Select the appropriate and pre-defined export 

driver 

 

The export drivers and their setup are ex-

plained in a later chapter. Please refer to this 

chapter for the proper configuration of the 

export driver. 

 

43. Click <OK> 

 

 

 

44. Click Print Setup… in the File menu 

45. Select the data set by highlighting and clicking 

<Add> 

Page Header header part 

File Names par and dat files names 

Measurement Data raw data 

Sample ID sample info (matrix1)* 

first measured data (matrix 2)* 

second measured data (matrix 3)* 

ratio ratio of readings (matrix 3)* 

Gen. Statistics measurement settings 

 

* the selection and content depends on the matrix 

definition done in the Calculation section 

 

46. Check if Automatic Print-out is required 

 

 

 

47. Type a header and/or footer 

 

 

 

 

48. Click <OK> 
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49. Go to File | Save As… 

50. Create and/or Select an appropriate directory, 

e.g. ParaTriStar2 

51. Select the file type Mikrowin Para File (*.par) 

52. Type a meaningful file name 

53. Click <Save> 
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8.3.2 Measurement with a Dual Label Assay protocol  
 

The protocol that has been created will be pre-selected. In case you want to perform a 

measurement you may simply select another protocol from the list. 

 

Note: In case injectors are to be used for reagent additions make sure the injec-

tion lines are properly cleaned and filled (primed). See chapter 9 of this 

manual. 

 

Note: Do not overfill the reagent trough as liquid spills in the injector compart-

ment may cause severe damage to the electrical system. Take special care 

when ice in the trough starts to melt. 

 

Note: Make sure the appropriate plate frame is inserted 

 

 

Follow the steps as described in paragraph 8.2.2 “Measurement with a single endpoint 

rotocol”. 
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8.4 Kinetic Measurement  
 

 

A kinetic measurement mode is appropriate for fast kinetics assays lasting over several 

seconds up to minutes, e.g. enzyme kinetics and Calcium influx 

 

 

8.4.1 Defining a protocol for a kinetic measurement  
 

Follow the instructions until step 15 as described in paragraph 8.2.1 for a single endpoint 

measurement. 

 

If you want to use an already existing protocol you may proceed with the next paragraph. 

 

16. Double-click Lumin. Kinetic for a luminescence 

kinetic reading 

Name give a (descriptive) name 

Total Time the entire kinetic time (max. 

7 days) 

Counting Time 0.05 to 600 s 

Check Use Shake instead of Delay if needed 

Delay 0 to 600 sec 

Repeats (are calculated) 

Emission Filter usually: No Filter 

Note: filters must be defined prior in the Instru-

ment menu 

Second Measurement may be checked in case of 

ratiometric kinetics, e.g. in BRET applications 

17. Click <OK> 

 

a second or third kinetic operation may be added, 

e.g. after a dispensing operation, and set up in 

the same way 
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18. Double-click Fluor. Kinetic for a fluorescence ki-

netic reading 

Name give a (descriptive) name 

Total Time the entire kinetic time (max. 

7 days) 

Counting Time 0.05 to 600 s 

Check Use Shake instead of Delay if needed 

Delay 0 to 600 s 

Repeats (are calculated) 

Lamp Energy 0 to 100 % 

Excitation Filter select from the list 

Emission Filter select from the list 

Note: filters must be defined prior in the Instru-

ment menu 

Operation Mode by plate or by well 

Second Measurement may be checked in case of 

ratiometric kinetics, e.g. in Calcium applications 

19. Click <OK> 

 

a second or third kinetic operation may be added, 

e.g. after a dispensing operation, and set up in 

the same way 

 

 

 

20. Double-click Abs. Kinetic for an absorbance ki-

netic reading 

Name give a (descriptive) name 

Total Time the entire kinetic time (max. 

7 days) 

Counting Time 0.05 to 600 s 

Check Use Shake instead of Delay if needed 

Delay 0 to 600 s 

Repeats (are calculated) 

Lamp Energy 0 to 100 % or Auto 

Note: Auto is recommended; it uses the calibrat-

ed energy setting specific for the selected filter 

Measurement Filter select from the list 

Note: filters must be defined prior in the Instru-

ment menu 

21. Click <OK> 

 

a second or third kinetic operation may be added, 

e.g. after a dispensing operation, and set up in 

the same way 
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22. The sequence of selected operations will be 

displayed in the center column 

Operations can be moved up or down by high-

lighting the operation and clicking on the respec-

tive arrow 

Operations can be deleted by highlighting and 

clicking the cross 

Details of the operation highlighted can be viewed 

on the right column 

An operation can be edited by double-clicking on 

it in the center column 

 

23. Check Temperature to activate the temperature 

control for this protocol 

24. Define the target temperature 

the instrument will start to heat the plate com-

partment as soon as the protocol file will be load-

ed 

Robot, Barcode and Multi Plate Data File Mode 

are currently not active 

 

25. Check Keep Plate after Measurement in case 

you want the microplate being kept inside the in-

strument after the reading being finished 

 

26. Click <OK> 

 

27. Click <OK> once more 

 

 

 

For further calculations of the measurements fol-

low the next steps: 

28. Go to Options | Matrix and click <Add Matrix> 

29. Highlight Matrix No. 2, click <Edit Matrix> and 

rename to e.g. AUC (Integral) 

Do the same for Matrix No. 3 (rename to e.g. 

Vmax) and Matrix No. 4 (rename to e.g. Peak) 

30. Click <OK> 

 

For export und print you have to refer to these 

matrices. 
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31. Change the view to the Calculation section 

32. Click on the 2 AUC (Integral) tab 

33. Click <Add Formula> and expand Kinetic calcu-

lation functions 

34. Select KITG(MEA) and click <OK> 

35. Click the double-cross to assign for all wells 

 

36. Proceed with the two other matrices alike: 

3 Vmax KDMS(MEA) 

 

4 Peak KMAX(MEA) 

 

When 2nd measurement has been checked MEA 

need to be replaced by LB1 and LB2 respectively 

and additional matrices may need to be created 

 

Should you wish to define any additional calcula-

tions please refer to the Mikrowin manual. 

 

 

 

     

 

37. To activate automatic export click Export Set-

up… in the File menu 

38. Select the appropriate and pre-defined export 

driver 

 

The export drivers and their setup are ex-

plained in a later chapter. Please refer to this 

chapter for the proper configuration of the 

export driver. 

 

39. Click <OK> 

 

 

 

40. Click Print Setup… in the File menu 

41. Select the data set by highlighting and clicking 

<Add> 

Page Header header part 

File Names par and dat files names 

Measurement Data raw data 

Sample ID sample info (matrix1)* 

AUC area under curve (matrix 2)* 

Vmax delta @ max slope (ma. 3)* 

Peak peak value (matrix 4)* 
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Gen. Statistics measurement settings 

Kinetics Graphics curves 

 

* the selection and content depends on the matrix 

definition done in the Calculation section 

 

42. Check if Automatic Print-out is required 

 

 

 

43. Type a header and/or footer 

 

 

 

 

44. Click <OK> 

 

 

 

 

45. Go to File | Save As… 

46. Create and/or Select an appropriate directory, 

e.g. ParaTriStar2 

47. Select the file type Mikrowin Para File (*.par) 

48. Type a meaningful file name 

49. Click <Save> 
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8.4.2 Kinetic measurement  
 

The protocol that has been created will be pre-selected. In case you want to perform a 

measurement you may simply select another protocol from the list. 

 

Note: In case injectors are to be used for reagent additions make sure the injec-

tion lines are properly cleaned and filled (primed). See chapter 9 of this 

manual. 

 

Note: Do not overfill the reagent trough as liquid spills in the injector compart-

ment may cause severe damage to the electrical system. Take special care 

when ice in the trough starts to melt. 

 

Note: Make sure the appropriate plate frame is inserted 

 

 

Follow the steps as described in paragraph 8.2.2 “Measurement with a single endpoint 

rotocol”. 
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8.5 Repeated Measurement  
 

 

A repeated measurement mode is appropriate for long-term kinetic assays lasting over 

multiple minutes up to several days, e.g. cellular luminescence, slow enzyme kinetics, 

long-term gene expression or growth monitoring 

 

8.5.1 Defining a protocol for a repeated measurement  
 

Follow the instructions until step 15 as described in paragraph 8.2.1 for a single endpoint 

measurement. 

 

If you want to use an already existing protocol you may proceed with the next paragraph. 

 

16. Double-click Lumin. Repeated for a lumines-

cence repeated reading 

Name give a (descriptive) name 

Total Time the entire kinetic time (max. 

7 days) 

Counting Time 0.05 to 600 s 

Cycle Time the time a specific well is 

read again in the consecu-

tive cycle 

Repeats (are calculated) 

Emission Filter usually: No Filter 

Note: filters must be defined prior in the Instru-

ment menu 

Injector 1, …2, …3 

Check Use Injector for an injection within the re-

peated cycle 

Injector Cycle 0 means prior to a meas-

urement 

Volume 10 to 100 µL 

Speed 1 to 5 

Operation Mode by plate or by well 

17. Click <OK> 

 

a second repeated operation may be added, e.g. 

for ratiometric applications (BRET) 
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18. Double-click Fluor. Repeated in the Fluores-

cence section for a fluorescence repeated read-

ing 

Name give a (descriptive) name 

Total Time the entire kinetic time (max. 

7 days) 

Counting Time 0.05 to 600 s 

Cycle Time the time a specific well is 

read again in the consecu-

tive cycle 

Repeats (are calculated) 

Lamp Energy 0 to 100 % 

Excitation Filter select from the list 

Emission Filter select from the list 

Note: filters must be defined prior in the Instru-

ment menu 

Injector 1, …2, …3 

Check Use Injector for an injection within the re-

peated cycle 

Injector Cycle 0 means prior to a meas-

urement 

Volume 10 to 100 µL 

Speed 1 to 5 

Operation Mode by plate or by well 

19. Click <OK> 

 

a second repeated operation may be added, e.g. 

for ratiometric applications (FRET) 
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20. Double-click Abs. Repeated in the Absorbance 

section for a absorbance repeated reading 

Name give a (descriptive) name 

Total Time the entire kinetic time (max. 

7 days) 

Counting Time 0.05 to 600 s 

Cycle Time the time a specific well is 

read again in the consecu-

tive cycle 

Repeats (are calculated) 

Lamp Energy 0 to 100 % or Auto 

Note: Auto is recommended; it uses the calibrat-

ed energy setting specific for the selected filter 

Measurement Filter select from the list 

Check Reference Measurement if needed 

Reference Filter select from the list 

Note: filters must be defined prior in the Instru-

ment menu 

Injector 1, …2, …3 

Check Use Injector for an injection within the re-

peated cycle 

Injector Cycle 0 means prior to a meas-

urement 

Volume 10 to 100 µL 

Speed 1 to 5 

Operation Mode by plate or by well 

21. Click <OK> 

 

a second repeated operation may be added, e.g. 

for ratiometric applications 
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22. The sequence of selected operations will be 

displayed in the center column 

Operations can be moved up or down by high-

lighting the operation and clicking on the respec-

tive arrow 

Operations can be deleted by highlighting and 

clicking the cross 

Details of the operation highlighted can be viewed 

on the right column 

An operation can be edited by double-clicking on 

it in the center column 

 

23. Check Temperature to activate the temperature 

control for this protocol 

24. Define the target temperature 

the instrument will start to heat the plate com-

partment as soon as the protocol file will be load-

ed 

Robot, Barcode and Multi Plate Data File Mode 

are currently not active 

 

25. Check Keep Plate after Measurement in case 

you want the microplate being kept inside the in-

strument after the reading being finished 

 

26. Click <OK> 

 

27. Click <OK> once more 

 

 

 

For further calculations of the measurements fol-

low the next steps: 

28. Go to Options | Matrix and click <Add Matrix> 

29. Highlight Matrix No. 2, click <Edit Matrix> and 

rename to e.g. AUC (Integral) 

Do the same for Matrix No. 3 (rename to e.g. 

Vmax) and Matrix No. 4 (rename to e.g. Peak) 

30. Click <OK> 

 

For export und print you have to refer to these 

matrices. 
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31. Change the view to the Calculation section 

32. Click on the 2 AUC (Integral) tab 

33. Click <Add Formula> and expand Kinetic calcu-

lation functions 

34. Select KITG(MEA) and click <OK> 

35. Click the double-cross to assign for all wells 

 

36. Proceed with the two other matrices alike: 

3 Vmax KDMS(MEA) 

 

4 Peak KMAX(MEA) 

 

When 2nd measurement has been checked MEA 

need to be replaced by LB1 and LB2 respectively 

and additional matrices may need to be created 

 

Should you wish to define any additional calcula-

tions please refer to the Mikrowin manual. 

 

 

 

     

 

37. To activate automatic export click Export Set-

up… in the File menu 

38. Select the appropriate and pre-defined export 

driver 

 

The export drivers and their setup are ex-

plained in a later chapter. Please refer to this 

chapter for the proper configuration of the 

export driver. 

 

39. Click <OK> 

 

 

 

40. Click Print Setup… in the File menu 

41. Select the data set by highlighting and clicking 

<Add> 

Page Header header part 

File Names par and dat files names 

Measurement Data raw data 

Sample ID sample info (matrix1)* 

AUC area under curve (matrix 2)* 

Vmax delta @ max slope (ma. 3)* 

Peak peak value (matrix 4)* 
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Gen. Statistics measurement settings 

Kinetics Graphics curves 

 

* the selection and content depends on the matrix 

definition done in the Calculation section 

 

42. Check if Automatic Print-out is required 

 

 

 

43. Type a header and/or footer 

 

 

 

 

44. Click <OK> 

 

 

 

 

45. Go to File | Save As… 

46. Create and/or Select an appropriate directory, 

e.g. ParaTriStar2 

47. Select the file type Mikrowin Para File (*.par) 

48. Type a meaningful file name 

49. Click <Save> 
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8.5.2 Repeated measurement  
 

The protocol that has been created will be pre-selected. In case you want to perform a 

measurement you may simply select another protocol from the list. 

 

Note: In case injectors are to be used for reagent additions make sure the injec-

tion lines are properly cleaned and filled (primed). See chapter 9 of this 

manual. 

 

Note: Do not overfill the reagent trough as liquid spills in the injector compart-

ment may cause severe damage to the electrical system. Take special care 

when ice in the trough starts to melt. 

 

Note: Make sure the appropriate plate frame is inserted 

 

 

Follow the steps as described in paragraph 8.2.2 “Measurement with a single endpoint 

rotocol”. 
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8.6 Scanning Measurement  
 

 

A scanning measurement mode is appropriate for assays with heterogeneous distribution 

of signal, e.g. cellular assays 

 

8.6.1 Defining a protocol for a scanning measurement  
 

Follow the instructions until step 15 as described in paragraph 8.2.1 for a single endpoint 

measurement. 

 

If you want to use an already existing protocol you may proceed with the next paragraph. 

 

16. Double-click Fluor. Scanning for a fluorescence 

scanning reading 

Name give a (descriptive) name 

Counting Time 0.05 to 600 s 

Lamp Energy 0 to 100 % 

Excitation Filter select from the list 

Emission Filter select from the list 

Note: filters must be defined prior in the Instru-

ment menu 

Steps 1 to 100 

scanning points in one di-

rection, the other direction 

will have the same amount 

of points 

Point Displacement distance between points 

Select rectangular or round matrix 

17. Click <OK> 

 

 

 

18. Double-click Abs. Scanning for a absorbance 

scanning reading 

Name give a (descriptive) name 

Counting Time 0.05 to 600 s 

Lamp Energy 0 to 100 % or Auto 

Note: Auto is recommended; it uses the calibrat-

ed energy setting specific for the selected filter 

Measurement Filter select from the list 

Note: filters must be defined prior in the Instru-

ment menu 

Steps 1 to 100 

scanning points in one di-

rection, the other direction 

will have the same amount 

of points 

Point Displacement distance between points 
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Select rectangular or round matrix 

19. Click <OK> 

 

20. The sequence of selected operations will be 

displayed in the center column 

Operations can be moved up or down by high-

lighting the operation and clicking on the respec-

tive arrow 

Operations can be deleted by highlighting and 

clicking the cross 

Details of the operation highlighted can be viewed 

on the right column 

An operation can be edited by double-clicking on 

it in the center column 

 

21. Check Temperature to activate the temperature 

control for this protocol 

22. Define the target temperature 

the instrument will start to heat the plate com-

partment as soon as the protocol file will be load-

ed 

Robot, Barcode and Multi Plate Data File Mode 

are currently not active 

 

23. Check Keep Plate after Measurement in case 

you want the microplate being kept inside the in-

strument after the reading being finished 

 

24. Click <OK> 

 

25. Click <OK> once more 

 

 

 

For further calculations of the measurements fol-

low the next steps: 

26. Go to Options | Matrix and click <Add Matrix>, 

click <Add Matrix> again 

27. Highlight Matrix No. 2, click <Edit Matrix> and 

rename to e.g. total 

Do the same for Matrix No. 3 (rename to e.g. 

max), Matrix No. 4 (rename to e.g. min) and Ma-

trix No. 5 (rename to e.g. average) 

28. Click <OK> 

 

For export und print you have to refer to these 

matrices. 
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29. Change the view to the Calculation section 

30. Click on the 2 total tab 

31. Click <Add Formula> and expand Area Scan 

functions 

32. Select SNUM(MEA) and click <OK> 

33. Type an asterisk (*) 

34. Click <Add Formula> and expand Area Scan 

functions 

35. Select SAVE(MEA) and click <OK> 

 

36. Click the double-cross to assign for all wells 

 

37. Proceed with the three other matrices alike: 

3 max SMAX(MEA) 

 

4 min SMIN(MEA) 

 

5 average SAVE(MEA) 

 

Should you wish to define any additional calcula-

tions please refer to the Mikrowin manual. 

 

 

 

        

 

38. To activate automatic export click Export Set-

up… in the File menu 

39. Select the appropriate and pre-defined export 

driver 

 

The export drivers and their setup are ex-

plained in a later chapter. Please refer to this 

chapter for the proper configuration of the 

export driver. 

 

40. Click <OK> 
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41. Click Print Setup… in the File menu 

42. Select the data set by highlighting and clicking 

<Add> 

Page Header header part 

File Names par and dat files names 

Sample ID sample info (matrix1)* 

total sum of readings (matrix 2)* 

max max. reading (matrix 3)* 

min min. reading (matrix 4)* 

average average of read. (matrix 5)* 

Gen. Statistics measurement settings 

Scanning Graphics blue-to-red map 

 

* the selection and content depends on the matrix 

definition done in the Calculation section 

 

43. Check if Automatic Print-out is required 

 

 

 

44. Type a header and/or footer 

 

 

 

 

45. Click <OK> 

 

 

 

 

 

46. Go to File | Save As… 

47. Create and/or Select an appropriate directory, 

e.g. ParaTriStar2 

48. Select the file type Mikrowin Para File (*.par) 

49. Type a meaningful file name 

50. Click <Save> 
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8.6.2 Scanning measurement  
 

The protocol that has been created will be pre-selected. In case you want to perform a 

measurement you may simply select another protocol from the list. 

 

Note: In case injectors are to be used for reagent additions make sure the injec-

tion lines are properly cleaned and filled (primed). See chapter 9 of this 

manual. 

 

Note: Do not overfill the reagent trough as liquid spills in the injector compart-

ment may cause severe damage to the electrical system. Take special care 

when ice in the trough starts to melt. 

 

Note: Make sure the appropriate plate frame is inserted 

 

 

Follow the steps as described in paragraph 8.2.2 “Measurement with a single endpoint 

rotocol”. 
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8.7 Measurement with curve fitting  
 

 

A raw data measurement that contains standards with known concentrations which are 

used to determine unknown concentrations of the samples. 

 

8.7.1 Defining a protocol with curve fitting 
 

When working with Blank subtraction it is recommended to change a global setting in 

Mikrowin first. 

 

1. Go to Installation | Settings and hit the ALT and 

the S keys 

2. Scroll to 014 DisableAutoBlankSubtraction 

3. Select the value Yes 

4. Click <OK> 

5. Click <OK> once more 

 

 

 

 

 

Next, follow the instructions until step 29 as described in paragraph 8.2.1 for a single 

endpoint measurement. 

 

If you want to use an already existing protocol you may proceed with the next paragraph. 

 

For further calculations of the measurements fol-

low the next steps: 

30. Go to Options | Matrix and click <Add Matrix>, 

click <Add Matrix> again 

31. Highlight Matrix No. 3, click <Edit Matrix> and 

rename to e.g. Blank subtr 

Do the same for Matrix No. 4 (rename to e.g. 

Conc) and Matrix No. 5 (rename to e.g. Average) 

32. Click <OK> 

 

For export und print you have to refer to this ma-

trices. 

 

 

 

33. Change the view to the Template section 

34. Click on the Partition tab and select a pattern 

matching your replicates in the Plate Partition 

drop box 

35. Click the double-cross to assign for all wells 
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36. Click on the Controls tab 

37. Select Blank (BC) in the Control Type drop box 

38. Click into wells A1/A2 to assign the blank to these 

wells 

 

 

 

39. Click <Yes> in Warning! Source matrix… dia-

logue 

 

 

 

 

40. Select Reader_Values in Source Matrix drop 

box 

 

 

 

 

 

 

41. Click on the Standards tab 

42. Click into Standard Concentration field and en-

ter the concentration of the first standard 

43. Select the matching dilution in the Dilution Fac-

tor drop box 

44. Click into B1/B2 (resp. the set of wells containing 

the first standard concentration) and drag the 

mouse to the set of wells with the last standard 

concentration 

In case you work with non-regular concentration 

series, click into the first set of wells, enter the 

concentration and hit the ENTER key 

Go ahead until the last concentration is being en-

tered 

 

 

 

 

 

 

 

 

 

 

 

 

 



LB 942 TriStar² Operating Manual 

 142 

45. Click <Yes> in Warning! Source matrix… dia-

logue 

 

 

 

 

46. Select the Source Matrix, e.g. Blank Subtr 

47. Select the curve fit Algorithm, e.g. Smoothed 

Cubic Spline 

48. Define the X and Y axis scales, e.g. log for both 

49. Type or select the axes Units 

50. Click on <Options> 

 

51. Select the Type of Data, whether they span a lin-

ear or a logarithmic range 

 

52. Smoothing Factor can be kept as Automatic 

 

53. Curve Extrapolation may be checked 

 

54. Click <OK> 

 

55. Click <OK> once more 

 

 

 

 

56. Change the view to the Calculation section 

57. Click on the 3 Blank subtr tab 

58. Type MA2 - BC into the Calculation Formula: 

MA2 = matrix 2 = contains the reader values 

BC = Blank Control 

59. Click the double-cross to assign for all wells 

 

60. Proceed with the two other matrices alike: 

4 Conc FIT(MA3) 

FIT = curve fitting 

MA3 = matrix 3 = the fit concentration calculation 

is applied to the values of matrix 3 

5 Average AVE(MA4) 

AVE = calculation of mean value 
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MA4 = matrix 2 = calculation is done on the val-

ues of matrix 4 (in this case the concentrations) 

 

Should you wish to define any additional calcula-

tions please refer to the Mikrowin manual. 

 

44. To activate automatic export click Export Set-

up… in the File menu 

45. Select the appropriate and pre-defined export 

driver 

 

The export drivers and their setup are ex-

plained in a later chapter. Please refer to this 

chapter for the proper configuration of the 

export driver. 

 

46. Click <OK> 

 

 

 

47. Click Print Setup… in the File menu 

48. Select the data set by highlighting and clicking 

<Add> 

Page Header header part 

File Names par and dat files names 

Measurement Data raw data 

Sample ID sample info (matrix1)* 

Reader_Values measured data (matrix 2)* 

Blank subtr blank corrected (matrix 3)* 

Conc calc. conc. (matrix 4)* 

Average Averages (matrix 5)* 

Gen. Statistics measurement settings 

Curvefit Graphics standard curve 

 

* the selection and content depends on the matrix 

definition done in the Calculation section 

 

49. Check if Automatic Print-out is required 

 

 

 

50. Type a header and/or footer 

 

 

 

 

51. Click <OK> 
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52. Go to File | Save As… 

53. Create and/or Select an appropriate directory, 

e.g. ParaTriStar2 

54. Select the file type Mikrowin Para File (*.par) 

55. Type a meaningful file name 

56. Click <Save> 

 

 

 

 

 

8.7.2 Measurement with a Curvefit parameter file  
 

The protocol that has been created will be pre-selected. In case you want to perform an-

other measurement you may simply select another protocol from the list. 

 

Note: In case injectors are to be used for reagent additions make sure the injec-

tion lines are properly cleaned and filled (primed). See chapter 9 of this 

manual. 

 

Note: Do not overfill the reagent trough as liquid spills in the injector compart-

ment may cause severe damage to the electrical system. Take special care 

when ice in the trough starts to melt. 

 

Note: Make sure the appropriate plate frame is inserted 

 

11. Click Open in the File menu 

12. Select File of type: Mikrowin Para File 

13. Select the appropriate file 

14. Click <Open> 

 

 

 

15. Enter a file name under which the measurement 

is to be stored 
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16. Click <Start> 

 

 

17. Insert the microplate with your samples: 

well A1 facing the rear and left 

Use the black frame for microplates with plate 

heights of 15 mm (±1 mm), e.g. 96 and 384 well 

plates 

Use the red frame for microplates with plate 

heights of 20 mm (±1 mm), e.g. 6, 12, 24 well 

plates 

18. Click <OK> 

 

 

 

19. The selected wells of the microplate will be 

measured and the numerical value of the signal 

will be displayed 

 

 

20. Select Unload Plate in the Instrument menu to 

retrieve the microplate (still in measurement posi-

tion) and remove it from the instrument 
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8.8 Export and print-out in Mikrowin 
 

 

The export of (calculated) results and raw (measurement) data is carried out via export 

drivers. The export drivers have to be installed and configured. Data can be exported in 

XLS and TXT file formats. 

 

 

8.8.1 Export Driver Configuration  
 

 Export drivers  have to be installed if you want to export data. In addition, 

you have to set up the export driver and you have to specify data structure, data matrices 

as well as header and footer. Data is exported depending on the driver selected and con-

figured in this dialog box. To use another data format, you can select another driver be-

fore running a measurement or set up the selected driver new. 

In the Installation Driver dialog box, select the Export tab to view the available drivers. 

You may choose: 

  
 Selection of export drivers 

 

 

Matrix Export Driver Driver (template) for export of calculated data with matrix (i.e. 

plate lay-out) structure. Only data that are visible on result matri-

ces can be exported. File formats may be EXCEL, Text (ASCII) 

and CSV. 

 

Line Export Driver Driver (template) for export of calculated data with list (i.e. table-

type) structure. Only data that are visible on result matrices can be 

exported. File formats may be EXCEL, Text (ASCII) and CSV. 

 

RawData Export Driver Driver (template) for export of all raw data. File formats may be 

EXCEL, Text (ASCII) and CSV. Whether data in the export file are 

presented in list or matrix format depends on the settings and data 

origin. 
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Matrix Export Driver If you select the Matrix export driver, you have to define the follow-

ing configuration:  

 

  
 Matrix export driver setup 

 

 

Export Layout Define the file layout. 

 

 Header Text box for entering a header. Click on the <Add> 

button to open a context menu and select a placeholder for the 

header. You may select several options one after another and sepa-

rate the placeholders either by a tab character (#TB) or by a key-

board entry (comma, space, etc.). 

 

  
 Context menu for entering header placeholders 

 

  Example:  

  Header with date, time and plate identification, separated by 

tab characters: #DT#TB#TM#TB#PI 

 

 Matrix In this text box you enter the matrices whose data you wish to 

export. In general, one exports only data from the result matrices. 

Make sure that the matrices and their numbers specified here is 

identical with the number of the result matrix in the parameter file. 

  Click <Add> to open the context menu and select the matrix 

number (1 – 15) or define the matrix name. Several matrices can be 

selected one after the other. They are entered in the matrix list. 

  Click <Delete> to delete the selected matrix from the matrix 

list. 
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 Footer Text box for entering a footer. Click the <Add> button to open 

a context menu and select a placeholder for the footer. You may se-

lect several options one after another and separate the placeholders 

either by a tab character (#TB) or by a keyboard entry (comma, 

space, etc.). This context menu includes the same options as the 

header context menu. 

 

 

Operation Mode Define additional options. 

 

 Export The proper setting is Always. 

 

 Add General Statistics Options are Yes or No. 

 

 

Export Target Define the target directory for the file as well as its format. In addition 

you may have the export file automatically opened. 

 

 Format You may select from Text File, XLS File, CSV File, 

CommPort and Clipboard. 

 

 Target Define the directory which the file is to be exported to. You 

may use the browse <…> button to locate an appropriate directory. 

 

 Adjustment You may define an executable command line which is 

executed after the export, e.g. to open the exported file. 

 

 

 

 

Line Export Driver Select this export driver to define a table-type file. Parameters (head-

er, matrix and footer as well as the target directory for data storage) 

are entered in the same manner as for an matrix-type file (see previ-

ous section). 

 

  
 Line export driver setup 
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Export Layout Define the file layout. 

 

 Header Text box for entering a header. Click on the <Add> 

button to open a context menu and select a placeholder for the 

header. You may select several options one after another and sepa-

rate the placeholders either by a tab character (#TB) or by a key-

board entry (comma, space, etc.). 

 

  
 Context menu for entering header placeholders 

 

 Line In this text box you enter the matrices whose data you wish to 

export. In general, one exports only data from the result matrices. 

Make sure that the matrices and their numbers specified here is 

identical with the number of the result matrix in the parameter file. 

  
 Context menu Line Export Driver 

 

 Click <Add> to open the context menu and select the matrix number 

(1 – 15) or define the matrix name. Several matrices can be selected 

one after the other. They are entered in the matrix list. 

 Click <Delete> to delete the selected matrix from the matrix list. 

 

 Footer Text box for entering a footer. Click the <Add> button to open 

a context menu and select a placeholder for the footer. You may se-

lect several options one after another and separate the placeholders 

either by a tab character (#TB) or by a keyboard entry (comma, 

space, etc.). This context menu includes the same options as the 

header context menu. 
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Data Selection Define additional options regarding data sources and positioning. 

 

 Consider Plate Partition This option should be checked when 

replicates are used and they are to be exported next to each other. 

 

 Skip Control Positions This option may be checked if values of 

Controls are not supposed to be exported. 

 

 Skip Positions without Sample ID Check if only samples with sam-

ple IDs are to be exported. 

 

 Skip Empty Positions of Matrix 1 This option may be used if the 

values of unused wells are not to be exported. Matrix 1 must contain 

an appropriate variable like MEA or LB 1. 

 

 

Operation Mode Define additional options. 

 

 Export The proper setting is Always. 

 

 Add General Statistics Options are Yes or No. 

 

 

Export Target Define the target directory for the file as well as its format. In addition 

you may have the export file automatically opened. 

 

 Format You may select from Text File, XLS File, CSV File, 

CommPort and Clipboard. 

 

 Target Define the directory which the file is to be exported to. You 

may use the browse <…> button to locate an appropriate directory. 

 

 Adjustment You may define an executable command line which is 

executed after the export, e.g. to open the exported file. 

 

 

 

RawData Export Driver With this export driver a file containing all raw data will be cre-

ated. 

 For the export of kinetic data the kinetic layout can be selected (see 

below). 

 When the Rawdata Export driver is used for values derived from 

scanning operations each well is displayed in a separate area with 

the individual reading points displayed in an X-Y matrix representing 

the scanning positions. 

 With data coming from multilabel measurements (e.g. BRET) with a 

single reading per wavelength the data are exported in a respective 

amount of matrices representing the plate layout. 

 Data from multi-plate readings (Batch mode) are also exported in a 

matrix orientation. Note: only single readings are supported! 
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Export Layout Define the file layout. 

 

 Header Text box for entering a header. Click on the <Add> 

button to open a context menu and select a placeholder for the 

header. You may select several options one after another and sepa-

rate the placeholders either by a tab character (#TB) or by a key-

board entry (comma, space, etc.). 

 

  
 Context menu for entering header placeholders 

 

 RawData Kinetik Layout 

 The selection Position/Time has a column adressed to each well 

position (left to right) and the consecutive readings are entered in 

lines (down). 

 The selection Time/Position has a line adressed to each well posi-

tion (down) and the consecutive readings are entered in columns (left 

to right). 

 

 Note: Keep in mind that EXCEL supports a maximum of 256 col-

umns. 

 

 Time Output Format 

 Select the time format a kinetic reading. Choices are: hh:mm:ss or 

sec.msec. 

 

 Footer Text box for entering a footer. Click the <Add> button to open 

a context menu and select a placeholder for the footer. You may se-

lect several options one after another and separate the placeholders 

either by a tab character (#TB) or by a keyboard entry (comma, 
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space, etc.). This context menu includes the same options as the 

header context menu. 

 

 

Operation Mode Define additional options. 

 

 Add General Statistics Options are Yes or No. 

 

 Add Sample ID information Check if you want that infor-

mation added to each value. 

 

 

Export Target Define the target directory for the file as well as its format. In addition 

you may have the export file automatically opened. 

 

 Format You may select from Text File, XLS File, CSV File, 

CommPort and Clipboard. 

 

 Target Define the directory which the file is to be exported to. You 

may use the browse <…> button to locate an appropriate directory. 

 

 Adjustment You may define an executable command line which is 

executed after the export, e.g. to open the exported file. 

 

 

 

8.8.2 Adding additional / replicating export drivers  
 

Especially in multi-user environment the individual users will have their own demands for 

export driver setups. To support this multiple copies of the export driver can be installed 

and each of the copies can be individually set up. 

 

It is recommended for convenience and security to create a new directory within the 

Mikrowin 2000 directory (e.g. called “Drivers”) and copy the original export drivers ma-

trix1.xdl, line1.xdl and rawdata1.xdl to it. 

 

 First, rename the export driver that is to be installed a second time by 

highlighting it in the Installation | Driver | Export menu. Hit the ALT 

and the R keys simultaneously. You can enter a new name for the driv-

er. Confirm with <OK>. 

 

  
 

 Now you can re-install the driver again by the clicking <Add Driver> and 

browsing to the driver directory you created. 
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 Select the respective driver in the dialogue displayed. 

 

  
 

 You may repeat this procedure as often as necessary to get an appro-

priate number of export drivers. 

 

 

 

8.8.3 Automatic export  
 

Choose the menu item File | Export Setup  to select the export driver that is to be loaded 

automatically upon successful completion of a reader run. If a driver has been selected 

for the active parameter file, data evaluation is performed after completion of the respec-

tive measurement and data export is carried out in accordance with the selected driver.  

 

Please keep in mind:  

This function is only valid for the active parameter file. 

Prerequisite for automatic data export is that the respective export driver has been in-

stalled and set up in the menu item Installation | Driver (see chapter Fehler! Verweis-

quelle konnte nicht gefunden werden.) and the export driver has been selected in the 

menu item File | Export (see chapter Fehler! Verweisquelle konnte nicht gefunden 

werden.). 

 

Open parameter file. 

Select File | Export Setup to open the File Export Setup dialog box.  

  
 File Export Setup dialog box 
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List of Active Export Driver 

Select the export driver you want to use for automatic data export upon successful com-

pletion of a reader run. Click on the arrow button to open the list showing the available 

drivers and select the driver you want. The selected drivers appear in the text box directly 

below the drop-down list box. 

To delete a driver from the list, select this driver and then click <Remove>. 

 

Click <OK> to accept your selection. 

 

You must save the parameter file after the export setup ! 

 

 

 

 

8.8.4 Export on demand 
 

 The following dialog supports manual export of program data. The 

data to be exported, the format as well as the export destination depend on the selected 

driver and its configuration. The actual data export is carried out by an export driver if you 

click on the <Export> button after a measurement. 

Open the parameter file you need. 

Select File | Export to open the File Export dialog box. 

 

  
 File Export dialog box with open driver list 

 

 

Active Export Driver Select the export driver you want to use for data export. Click 

on the arrow button to open the list showing the available drivers and select the driver you 

want. Please keep in mind that you have set up the driver you have selected here in the 

menu Installation | Driver | Export. Otherwise, no data will be transferred! 

 

Export Target Information File Name 

 Shows the file name of the active parameter file. An extension identi-

fying the selected driver is appended (XLS for Excel files and TXT for ASCII files). The file 

name can be edited. 

  

 Directory 

 The target directory has been defined by the selected export driver 

during installation. Click the <Browse> button to select another target directory. 

 

 Click <OK> to accept your selection. 
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The export will be executed automatically if selected in the respective protocol file. 
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8.8.5 Data Print-out  
 

Data and results can be printed automatically whenever a measurement with a parameter 

file has been done - Automatic Print-out has to be checked as described in the previous 

chapters – or on demand for the currently loaded data file. 

 

1. Go to Print Setup… in the File menu 

2. Select the appropriate items by highlighting and 

clicking <Add> 

 

 

 

3. You may check the settings and layout by select-

ing Print Preview  in the File menu to get a pre-

view of the print-out 

4. Select Print in the File menu to start printing the 

data 

 

 

 

The print-out will be executed automatically if checked when created in the respective pa-

rameter file. 

 

 

8.8.6 Print-out of parameter file settings 
 

All settings including the calculations can be printed by clicking Template Print-out in the 

File menu. The information will be presented as a HTML file in the web browser from whe-

re you can print the content. 

 

 



LB 942 TriStar² Operating Manual 

 157 

9. Maintenance  
 

 

9.1 Cleaning the Instrument 
 

9.1.1 Cleaning the instrument surface 
 

The surface of the instrument is protected by a washable finish. Dirty or dusty surfaces 

should be cleaned using a damp cloth or optical grade tissue. If necessary, use a mild de-

tergent or diluted EtOH. 

 

Do not use a scouring agent! 

 

 

9.1.2 Cleaning the inside of the instrument 
 

The inside of the instrument does not need to be cleaned regularly. Only in case liquid 

spillage it may be necessary to clean the inside. 

 

Do not open the instrument by yourself! Call a Berthold Technologies technical 

support person. 

 

Before opening the instrument, turn it off and disconnect it from power supply! 

 

Open the screws on the instrument cover to clean the instrument inside. Then detach the 

cover by moving or lifting it carefully. 

 

Always keep the sample holders and the entire inside of the instrument clean. Wipe off 

any dirt using a damp cloth or optical grade tissue. Use cotton buds for corners. Remove 

dirt quickly so it does not get fry and may not have any adverse effect on moving parts. 

 

 

 

9.2 Cleaning Tubing   
 

Injector tubing have to be washed 

 before starting work 

 before changing reagents  

 at the end of each work session before turning off the in-

strument 

 after longer periods of inactivity 

 

Use solutions recommended by the kit manufacturer. 

 
Other recommended cleaning reagents are  
o deionised water 
o diluted alcohol: 70 % Ethanol, Propanol 
o 2 - 5 % hypochlorite solution (“bleach”) 
o 0.5 – 1 M Chloric acid (HCl) 
o 0.5 – 1 M Sodium hydroxide (NaOH) 
o 0.1 % SDS 
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o Non-foaming detergent (up to 10 %) 
 

Some of these reagents may be hazardous. Please refer to 
the respective safety instructions (e.g. R and S codes) of 
the supplier. 

 

Berthold Technologies´ cleaning solution CLEANIT Stand-

ard (product code 45218) is an efficient and proven clean-

ing solution for most of the common reagents in use. It is 

recommended to use this solution at least once a weak to 

ensure a long lifetime of the injectors! 

 

Injector tubing have to be primed 

 prior to each measurement using the respective reagents. 

 

 

 

1. Click Injector Settings in the Instrument menu 

2. Define the default number of wash cycles – 50 

is recommended 

3. check the use of the Berthold Technologies 

Washplate (when available) 

 

 

4. Click Wash  in the Instrument menu 
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5. Define the number of Wash Cycles 

 

Make sure the total Wash volume does not 

exceed the volume of the plate being used! 

 

6. Select the respective injector(s) 

7. Click <Next> 

 

 

8. Load a Wash plate 

9. Click <Next> 

 

 

10. Attach the reservoir containing the appropriate-

Wash Solution (see above) 

11. Click <Next> 
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12. Wait until the wash cycles are completed 

 

 

13. Click <Close> 

 

 

14. Remove Wash plate by clicking Unload Plate in 

the Instrument menu 

 

 

 

 

Note: It is recommended to leave deionised water in the injection lines 

during idle periods of hours up to a few days. 
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 Only in case the instrument stays idle for multiple days up to 

weeks it is recommended to empty the lines by starting the Wash 

procedure without a wash solution. 

 

 

 

9.3 Priming Tubing   
 

9.3.1 Priming before Measurement 
 

Injection lines have to be primed (filled) prior to measurements which require 

the use of injectors for reagent addition. 

 

Note: It is strongly recommended to perform the priming with deionized 

water first and leaving the lines filled with deionized water before 

priming with reagents. 

  

 This procedure avoids reagents aerosol splashes at the injector 

tips and thus contamination of the instrument. 

 

Note: Do not overfill the reagent trough as liquid spills in the injector compart-

ment may cause severe damage to the electrical system. Take special care 

when ice in the trough starts to melt. 

 

 

 

1. Click Injector Settings in the Instrument menu  

2. Define the default number of prime cycles – 12 

is recommended – which will be used for the de-

fault priming and check the use of the Berthold 

Technologies Washplate 
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3. Click Prime  in the Instrument menu 

 

 

4. Check Berthold Washplate (when available) 

5. Select the prime mode 

a. Check Use Customized Prime to select a 

user defined method 

(see next chapter) 

b. Uncheck Use Customized Prime to use 

the default prime mode 

6. Select the respective injector(s) 

7. Click <Next> 

 

 

8. Load a prime plate / wash plate 

9. Click <Next> 
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10. Attach the reservoir(s) containing the appropriate 

Assay Reagents (or deionized water; see above) 

11. Click <Next> 

 

 

12. Wait for the Prime procedure to be finished for 

one injector 

 

 

13. Click <Close> 
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14. Remove prime / wash plate by clicking Unload 

Plate in the Instrument menu 

 

 

15. The instrument is now ready for use  
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9.3.2 Customizing the Priming Sequence 
 

Some reagents (e.g. high viscosity) or solutions (e.g. cells) require spe-

cial priming procedures which can be defined individually. 

 

 

1. Click Prime Customize  in the Tools menu 

 

 

2. The Prime Customize dialog will be displayed 

 

 

clicking on  in the Sequence window will ex-

pand the respective folders and display the set-

tings 

 

 

 

3. The respective operation can be selected for the 

prime sequence by dragging it from the left col-

umn to the right column (Sequence) 

 

 

 

 

to change the sequence the arrow buttons can 

be used 
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to remove an operation the button  can be 

used 

 
 

 

The operations and their settings: 

To change the settings 

 expand the operation 

 expand the setting 

 click onto the number 

 click onto the number a 2nd time 

 type the appropriate number 

 confirm with the ENTER key 

 

 

 

a. Injection 

the injector is filled with the max. injection vol-

ume from the reagent reservoir and injects the 

set volume 

Volume percentage of the max. inj. vol. 

Delay delay before the operation in sec 

Speed 1 … 10 

Repeats number of repeats 

 

 

b. Delay 

a delay time that elapses between operations, 

e.g. to mimic the injection timing of the assay 

(this can be important with a cell suspension) 

Delay elapsing time in sec 

 

 

 

c. Oscillate 

the injector is (partly) filled and oscillates be-

tween the set positions (back into the reagent 

reservoir) 

Start. Point percentage of the max. inj. vol. 

End Point percentage of the max. inj. vol. 

Speed 1 … 10 

Repeats number of repeats 

 

 

 

d. Ventilate 

the injector is completely filled (beyond the 

max. injection volume) from the reagent res-

ervoir and injects the total volume of the bel-

low 
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Delay delay before the operation in sec 

Speed 1 … 10 

Repeats number of repeats 

 

 

e. Prime 

the injector is filled with the max. injection vol-

ume from the reagent reservoir and injects the 

full volume 

Delay delay before the operation in sec 

Speed 1 … 10 

Repeats number of repeats 

 

 

 

4. After the sequence is completed enter a name 

for this priming sequence and click <Save> 

 

the file will get the extension .wpe 

 

the respective directory will be displayed 

 

 
 

 

5. Close the dialog by clicking  
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9.4 Emptying Tubing   
 

This operation can be used to empty the injection lines after the meas-

urement and re-collect valuable reagents in the reagent reservoirs. 

 

Note: Make sure the reagent reservoir are connected to the injection tubings ! 

 

 

1. Click Unload Injector in the Instrument menu 

 

 

2. Define the Number of Unload cycles 

 

each cycle is equivalent to the max. injection 

volume of the injector installed 

 

a minimum of 10 is recommended 

 

3. Define whether Injector 1 or Injector 2 or Injec-

tor 3 or any combination are to be emptied 

4. Click <Next> 

 

 

5. Wait for the unload operation to be finished 
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6. Click <Close> 

 

 

 

 



LB 942 TriStar² Operating Manual 

 170 

9.5 Preparations for transport  
 

The following safety provisions have to be taken to transport or ship the instrument: 

 

 Turn instrument off and disconnect it from mains 
 

 Insert transport safety device(s) 
 

  

  

 For shipping you must use the original transportation case 

 Encase the instrument with the styrofoam parts 

 Tape shipping carton tightly 

 Have a filled in Declaration on Decontamination accompany the in-
strument when shipping back to Berthold Technologies or one of its rep-
resentatives 
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10. Trouble shooting   
 

 

Symptom Possible cause Solution 

LED flashes red accompa-

nied by 2 beeps 

CAN module not correctly in-

stalled 

1) switch instrument off 

and on again 

2) call service 

LED stays orange Cable between instrument and 

computer is not connected 

Wrong COM assigned 

1) attach cable properly 

 

2) use service software and 

run “Scan COM ports” 

command 

Instrument does not respond 

to software commands (sta-

tus “Timeout Error”) 

Cable between instrument and 

computer is not connected 

Wrong COM assigned 

1) attach cable properly 

 

2) use service software and 

run “Scan COM ports” 

command 

LED stays dark Instrument not switched on 

Mains not plugged in 

mains supply deactivated 

 

mains plug defective 

1) switch instrument on 

2) plug in mains 

3) check with local house 

electrician 

4) call service 

Lower signal than expected Pipetting/preparation error 

 

 

 

 

substrate consumed 

1) verify by checking replicate 

and other samples / con-

trols / standards and  

prepare faulty sample 

again 

2) prepare new plate and 

read immediately after add-

ing substrate 

Signal not above back-

ground readings 

No sample 

No reagents added 

1) check sample preparation 

2) add reagents 

No signal at all Faulty PMT Call service 

Plate is not moved to meas-

urement position 

Plate not correctly inserted 

Wrong frame 

Plate too high 

1) insert plate correctly 

2) change frame 

3) use another plate with a to-

tal max. height of 16 or 21 

mm respectively 
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Error message no plate No plate 

Wrong frame 

1) insert plate 

2) insert black frame for 15 

mm plates 

High background signal Reagents not prepared properly 

Reagents contaminated 

Plate contaminated 

3) prepare reagents properly 

4) prepare fresh reagents 

5) use another clean plate 

6) call service 

Standard curve cannot be 

calculated 

Standards pipetted in wrong or-

der 

1) prepare new plate with cor-

rect layout of standards 

2) use the edit function in the 

standard curve tab 

Excel Files cannot be 

opened 

Excel is not installed Install Excel 

Adobe PDF files cannot be 

opened 

Adobe Acrobat Reader is not in-

stalled 

Install Adobe Acrobat 
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11. Technical Data   
 

 

Mains Supply 100 – 240 VAC 

Fluctuations must not exceed ± 10 %; max. voltage 253 VAC 

50 / 60 Hz 

Operating voltage 24 VDC 

Power consumption 220 VA 

Certifications CE, UL, CSA 

Safety standards EN 61010-1, EN 61326-1, EN 61000-3-2, EN 61000-3-3 

Installation category II 

Temperature range storage:   0° - 40°C 

operation: 15° - 35°C 

Humidity 10 – 80%, not condensing 

maximum relative humidity of 80 % for temperatures up to 31 °C decreas-

ing linearly to 50 % relative humidity up to 40 °C 

Altitude < 2000 m (above sea level) 

Pollution degree 2 

Dimensions 391 x 470 x 344 mm (W x D x H) 

Weight 21 kg 

Plate formats 6 to 384 well, solid and strip 

Dimensions 128 x 86 mm (L x W), height 14.0 – 21.0 mm (adapters nec-

essary 

Petri dishes 35 and 60 mm 

Measurement tech-

nology 

Luminescence 

Fluorescence 

Absorbance 

Operation modes Integral measurement: 0.1 – 200 s 

Dual integral measurement: 0.1 – 200 s each 

Kinetic 

Repeated 

Scanning 

Delay: 0 – 600 s 

Shaking 

Injection 

Detector Photomultiplier operated in single photon counting technology 

Sensitivity Luminescence: 

ATP: 6 amol/well (96) 

Fluorescence: 

FITC: 0.3 fmol/well (384) 

Absorbance: 

Accuracy better 2 %, precision better 0.6 % (96 well, 2 OD) 

Dynamic Range 6 orders of magnitude 

Crosstalk 10-6 (black plates) 

Interface(s) USB 

Operating system Win Vista, Win 7 



LB 942 TriStar² Operating Manual 

 174 

PC requirements Pentium, 500 MHz (or better), CD ROM drive, USB port 

Software wizard support for parameter entries 

input of plate format 

selection of wells 

raw data assays (reporter genes, caspases, etc) 

dual raw data assays (e.g. dual reporter genes) 

kinetic 

repeated 

scanning 

ratio calculation or subtraction 

data export: EXCEL 
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12. Appendix 
 

 

a. Customer Reply Form  
 

 

 

Send Customer Reply Form to: 

 

Berthold Technologies GmbH & Co KG 

Technical Support 

Calmbacher Str. 22 

75323 Bad Wildbad 

Germany 

Phone: +49 7081 177 114 

Fax: +49 7081 177 301 

Email: service@berthold.com 

 

or your local representative. 

 

 

A blank Customer Reply Form can be found overleaf. 

 

 

mailto:service@berthold.com


LB 942 TriStar² Operating Manual 

 176 

Customer Reply Form 

Date: Customer no.:  

Name:   

Company:   

Department:   

Address:   

Address:   

Phone: Fax:  

Email:   

 

Instrument:  

ID no.:  

Serial no.:  

Embedded software version:  

Instrument driver software version:  

Accessory instruments: 

   

PC Software: PC software version:  

Windows version:  

Computer type: CPU type:  

Other installed software: 

   

Time when problem occurred (Windows clock):   

Error message(s): 

Description of the problem: 
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b. Confirmation on Decontamination Form  
 

Confirmation on Decontamination 
If you return an instrument to BERTHOLD TECHNOLOGIES for servicing purposes which is not properly decon-

taminated, there will be a health risk for BERTHOLD TECHNOLOGIES employees. We therefore need your con-

firmation that the instrument was decontaminated and cleaned properly before shipping. If the form below is not 

filled in accordingly and completely, we are forced to reject the instrument. Please understand that this is intended 

to protect our employees from any hazards. 

Please put one copy into the shipping box and a duplicate into an envelope attached to the outside. 

  (Please use capital letters !) 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

instrument / component: 

   

serial no.: 

   

instrument or component has come into contact with: 

[  ]  radioactive substances 

 Isotope(s):  

   

means of decontamination applied: 

   

   

[  ]  chemical reagents 

 specify:  

 R and S rules:  

means of decontamination applied: 

   

   

[  ]  biological material 

 specifiy:  

   

means of decontamination applied: 

   

   

[  ]  contagious agents 

 specify:  

   

means of decontamination applied: 

   

   

 indicate security level of the laboratory the instrument has been used in 

 [  ] S1 [  ] S2 [  ] S3  [  ] S4 

 

[  ]  I hereby confirm that the instrument or component specified above was not 

 contaminated with any of the above mentioned substances / reagents / agents 

 

[  ]  I hereby confirm that the instrument or component specified above was 

 decontaminated / cleansed using the appropriate method 

 

date:   signature:  

name:  

   

title:   

phone:  

fax:   

address:  

   

   

   

7-40.12 – 31531/03 
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Data Export via Export 102 

Data Print-out 156 
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Device driver 34 
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Emision Filters 40 

Emptying tubing 168 

Excitation Filters 38 

Export 45, 102 

export automatic 153 

Export driver 146 
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—F— 

fast kinetics 70, 122 

File | Export 154 

File | Export Setup 153 

File Menu 45 

File Name 43 

File Type 43 

Filling tubing 161 
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Hard lock 28, 30 

Help Menu 50 

—I— 

ICE Software Installation 25 

ICE Software Options 21 

Important Rules 21 

Installation 23 

Installing Filters 38 

Instrument Menu 47 

Intended use 21 

—K— 

Kinetic Measurement 70, 77, 122, 127 

Kinetic Protocol 70, 122 

—L— 

LED 9 

Line Export Driver 148 

long-term kinetics 80, 128 

—M— 

Mains Switch 24 

Maintenance 157 

Matrix Export Driver 147 

Microplates 21 

Mikrowin 2000 Software 

Installation 28 

—P— 

Photon Counting 21 

Plate Editor 51, 104 

Power Supply 19, 23 

Preparations for Transport 170 

Prime 161, 162 

Prime Customize 165 

Print 45, 103, 156 

Print Preview 103, 156 
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RawData Export Driver 150 

Repeated Measurement 80, 88, 128, 134 

Repeated Protocol 80, 128 

RLU/s 37 
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—S— 

Safety Instructions 10 

Save Data File As… 101 

Scanning Measurement 91, 98, 135, 139 

Scanning Protocol 91, 135 

Second Measurement 73, 74, 122, 123 

Set Up 23 

Sicherheitshinweise 16 

Single Endpoint Measurement 60, 113 

Single Endpoint Protocol 53, 106 

Single Raw Data Measurement 53, 106 

Software Installation 25 

Special Spare Parts 19 

Start-up Screen 44 

System Overview 21 

—T— 

Technical Data 173 

Temperature Control54, 63, 71, 81, 92, 110, 117, 124, 131, 136 

Template Print-out 156 

Tools Menu 49 

Transportation Safety Device 23 

TriStar² Driver Installation 32 

Trouble Shooting 171 

Typographical Conventions 9 

—U— 

Unload Injector 168 

Unpacking 23 

USB Cable 23 

USB Port 23 

User Interface 44 

—V— 

View Menu 46 

—W— 

Warranty Statement 19 

Wash 157, 158 

Wash Solutions 157 

Windows OS 25, 28 

 

 

 

 

 

 

 

 

 


